I.' :
s experian.

Experian Data Quality for
Salesforce

Installation and Configuration Guide




Copyright

All copyright and other rights in this manual and the licensed programs described in this manual are the
property of Experian Ltd. save for copyright in data in respect of which the copyright belongs to the relevant
data provider.

No part of this manual may be copied, reproduced, translated or reduced to any electronic medium or
machine readable form without the written consent of Experian Ltd.

© Experian Ltd. 2020
Version 6.2, Revision 18 May 2020.
Contacts and Support

For resolutions to common issues, answers to frequently asked questions and hints and tips for using our
products: https://www.edg.com/support

For more information about us and to get in touch: https://www.edg.com
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License Information

The Global Data Quality for Salesforce solution uses software that are subject to the following copyright
notices:

Apache Software Foundation

Software developed by The Apache Software Foundation (http://www.apache.org/), redistribution of which is
subject to the Apache License.

You may obtain a copy of the License at: http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed
on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See
the License for the specific language governing permissions and limitations under the License

The MIT License (MIT)
Copyright (c) 2007 James Newton-King

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

AutoMapper
Copyright (c) 2010 Jimmy Bogard

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY



http://www.apache.org/
http://www.apache.org/licenses/LICENSE-2.0

CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE

Force.com-Toolkit-for-NET
Copyright (c) 2013, salesforce.com
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the salesforce.com nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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INTRODUCTION

Your organisation’s data is a strategic asset and competitive differentiator, however actionable insights can
only be achieved through proper data quality. Connect more effectively with your customers through accurate
and clean data.

Global Data Quality for Salesforce enables users to verify addresses, email and phone numbers in real-time at
the point of entry, instantly detecting and removing incorrect or incomplete contact data. Batch mode address
cleansing will correct any inaccuracies that already exist in your database, ideal for cleaning list imports or
running regular database audits.

This document provides an overview of the steps required for manually installing and configuring address,
email and phone verification for Salesforce. It will take you through the standard manual installation,
integration and configuration process.

Customers who wish to utilise EDQ service within the Accounts, Contacts, Contracts or Leads standard
objects can use The Experian Quick Start Wizard and accompanying Quick Start Guide to quickly configure
the solution. Using the wizard will bypass a number of steps detailed in this guide.

If you wish to manually configure and install the solution or wish to utilize EDQ service within any other
standard or custom objects, follow the detailed steps outlined in this document.

See "Product Documentation" on page 4 for a full list of the other documentation available for the Global Data
Quality for Salesforce solution.




What This Guide Contains

This guide walks you through the manual process of installaing and configuring the Global Data Quality for
Salesforce solution.

Customers who wish to utilise EDQ service within the Accounts, Contacts, Contracts or Leads standard
objects can use The Experian Quick Start Wizard and accompanying Quick Start Guide to quickly configure
the solution. Using the wizard will bypass a number of steps detailed in this guide.

This guide is made up of two parts:

Installation

You can install the Global Data Quality for Salesforce application from the AppExchange. A full breakdown of
installation steps can be found on page 5.

Configuration

Configuring your Global Data Quality for Salesforce solution requires the completion of four steps:

1. Add the EDQ Validation Status and Timestamp custom fields to your Objects.

2. Integrate the solution into your Visualforce pages.

3. Add custom triggers which allow EDQ to maintain the Validation Status and Timestamp custom fields you
created in step 1.

4. Configure Address, Email and Phone validation settings via the Experian Data Quality Administration area.

Prerequisites

To configure and use the solution, you will require the following:

e Global Data Quality for Salesforce Application Key;
e Supported Salesforce Editions:

= Enterprise;

= Unlimited;

= Performance;

Note: If you have not received your Application Key please contact your sales representative or contact
Experian Technical Support. Alternatively, you can sign up for a free trial from within the app once
downloaded into your Salesforce environment.

Location Phone
United Kingdom +44 (0)20 7819 5760
USA and Canada +1 (888) 707-8822

Melbourne: +61 (0) 3 8699 0100

A lia, New Zeal i
ustralia, New Zealand and Singapore Sydney: +61 (0) 2 8907 7200

France and the Netherlands +33(0) 170394555




Product Documentation

This section provides a comprehensive list of the documentation available, and information about where it can
be located.

Installation & Configuration Guide

The Installation & Configuration Guide provides detailed information about installing and configuring the
Global Data Quality for Salesforce solution. It also provides information about administering the solution using
the EDQ Administration area. The guide should be used by administrators who wish to administer EDQ service
within any standard or custom object and comprehensively details the manual end to end installation and
configuration process.

Quick Start Guide

The Quick Start Guide provides an overview of the solution and how to quickly get started using the Experian
Quick Start Wizard. Customers who wish to utilise EDQ service within the Accounts, Contacts, Contracts or
Leads standard objects can use The Experian Quick Start Wizard and accompanying Quick Start Guide to
quickly configure the solution. Using the wizard will bypass a number of steps detailed within the Installation
& Configuration Guide.

User Guide

The User Guide provides detailed information on the respective contact data validation modes and techniques
available. It will provide users with indepth insight into how to use the solution and includes both real time
address, email and phone validation and batch mode address cleansing.

All guides are available on our AppExchange listing within the Details tab — click here to view.
Data Guide

A Data Guide is available for each dataset, and provides specific information and search tips for each dataset.
The Data Guide can be used in conjunction with the other documentation supplied with this product.

Data Guides are available on the Experian Data Quality support site - https://www.edg.com/support
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INSTALLATION

Install the Global Data Quality for Salesforce solution from the AppExchange:
https://appexchange.salesforce.com/listingDetail?listingld=aON300000055e86EAA
1. Click Get It Now and login with your Salesforce credentials.

Note: You must use an account with administrator access to install this application.

2. You will be taken to the Install Package page where you should specify Install for all Users.

I Install EDQ Global Data Quality

By Experian QAS

(" Install for Admins Only @ Install for All Users (" Install for Specific Profiles...

m cance'

Make sure you select Install for All Users before you click on the Install button to proceed.
3. After clicking the Install button the Approve Third-Party Access window will appear. Check the 'Yes, grant
access to these third-party web sites' checkbox and then click Continue.

Approve Third-Party Access

This package may send or receive data from third-party websites. Make sure
you trust these websites. What if you are unsure?

Website SSL Encrypted

sfv5.online.gas.com (v

|7 Yes, grant access to these third-party web sites

m

4. After you click on the Continue button the Installation process will start as shown on the screenshot
below.
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¥ Install EDQ Global Data Quality

By Experian QAS

Installing and granting access to all Users...

i\

5. Installation is complete once you see the following page:

¥ Install EDQ Global Data Quality

By Experian QAS

o Installation Complete!

Done

Congratulations, you have just installed Global Data Quality for Salesforce.

The next step is to configure the solution.




CONFIGURATION

The following steps outline the process of configuring the solution. Turn to the relevant pages for step by step
instructions.

Step Details
1. Add Validation Status and Validation Timestamp Custom Fields to Your Objects Page 7
2. Add Validation Status and Validation Timestamp Custom Fields to Your Object Page 12
Layouts
3. Integrate Global Data Quality into Your Salesforce Pages Page 13
4. Add Custom Trigger(s) to Maintain Validation Status and Validation Timestamp Page 33




Add Validation Status and Validation Timestamp
Custom Fields to Your Objects

In order to utilize the solution to its full extent, you should create custom fields to store the validation status
and validation timestamp for the respective touchpoint. The process can be done for any standard or custom
object (e.g. Accounts, Leads, Contacts, etc.) in your Salesforce instance.

Address Custom Fields
Validation Status Field

1. Go to Setup > Objects and Fields > Object Manager > {Object Name} (e.g. Account).
2. Navigate to the Fields & Relationships section and click the New button at the top of the section.

* SETUP > OBJECT MANAGER
Account

Detalls Fields & Relationships Q New | Fleld Dependencies  Set History Tracking
&7+ Items, Sorted by Fleid Label

I Flelds & Relationships

FIELD LABEL & FIELD NAME DATA TYPE CONTROLLING FIELD INDEXED
Page Layouts

Account Name Name Name ~
Lightning Record Pages

Account Number AccountNumber Text(40)
Buttons, Links, and Actlons

Account Owner Ownerld Lookup({User) v

3. For Data Type choose Text.

$ SETUP > OBJECT MAMAGER

Account
(@] A read-only field that displays the sum, minimum, or maximum value of a field in a related list or the record count of all records listed in a related list
) Roll-Up Summary
Detalls
- Craates 3 relationship that links this obj to another obj The relationship field allows users to click on 3 lookup icon to select 3 value from 3 up list
Flelds & Relationships © Lookup Relstionship v et o1 chiest g g FoRn
The other object is the source of the values in the list.
Page Layouts Bt o E A Crestes = relationship that finks this objsct to an extemal object whose dats is stored cutside the Sakesforcs org.

Lightning Record Pages

() Checkbox Allows users 1o selent 3 True (checked) or False (unchecked) value

Buttons, Links, and Actlons Allows users to enter a dollar or other cumency ameunt and automatically formats the fiekd as a curmency amount. This can be useful if you export data to

() currency
Exoel or anather spreadsheet

Compact Layouts

O pate Allows users to enter a date of pick a date from a popup calendar

Object Umlts O paterrime Allows users to enter 3 date and time, or pick a date from 3 popup calendar. When users click 2 date in the popup, that date and the current time are entered
into the Date/Time fiekd.
Record Types
O Email Allows users 1o enter an email address, which is validated to ensure proper format. If this fiekd is Specified for a contact or lead, users can choose the

address when clicking Send an Email. Note that custom email addresses cannot be used for mass emails.
Related Lookup Fliters ~J

's) Allows users to define locations. Includes Ixtitude and longitude components, and can be used to caloulate distance.
./ Geolocation

Search Layouts

O number Allows users to enter any number, Leading zeros are removed.
Triggers e Allows users to enter a peroentage number, for example, 10" and automatically adds the paroent sign to the number.
Valldatlon Rules O Phone Allows users to enter any phone numbar, Automatically formats it 35 3 phong number,

Hierarchy Columns O Pickiist Allows users to sslect 3 value from a list you define.

O Pickiist (Muti-Select) Allows users to ssiect multipie values from a list you define.

@ et Allows users to enter any combination of letters and numbars

4. Click Next.
5. Enter the following details:

Field Label: Shipping Address Validation Status
Length: 100
Field Name: Shipping_Address_Validation_Status




Note: We advise aligning Field Label and Field Name naming conventions with the respective address
configuration for the required Object (in the example above the naming convention is aligned with
Shipping Address). For example change “Shipping” to “Billing” or “Mailing” depending on the required
address configuration.

SETUP

Object Manager

Account
New Custom Field

Step 2. Enter the details Step 2 of 4

| Previous | | Next| Cancel

Help for this Page 0

Field Label  [Ehipping Address Validatidnl | i

Please enter the maximum length for a text field below.
tength oo ]
Field Name Ihipping_Address_\c'aIidaﬁon i

Description

Help Text

6. Click Next.

7. You will be redirected to the Establish Field-Level Security page where you can select the profiles to
which you want to grant/edit access to this field via field-level security. The field will be hidden from all
profiles if you do not add it to field-level security.

8. Click Next.

9. You will be redirected to the Add to Page Layouts page.

10. Click Save & New to continue with the next step - creating the Validation Timestamp custom field.

Validation Timestamp Field

This custom field provides the last address validation date and time. To create the Validation Timestamp field
please repeat steps 1-6 used to create the Validation Status field using the following values:

For Data Type choose Date/Time.
Field Label: Shipping Address Validation Timestamp
Field Name: Shipping_Address_Validation_Timestamp

Note: We advise aligning Field Label and Field Name naming conventions with the respective address
configuration for the required Object (in the example above the naming convention is aligned with
Shipping Address). For example change “Shipping” to “Billing” or “Mailing" depending on the required
address configuration.




Email Custom Fields

Note: You should only follow these steps if you are going to use Email Verification.

Repeat steps 1-6 from the Address Custom Fields section for each Email touchpoint in order to create the
Validation Status and Validation Timestamp custom fields for Email. Please use the values below when creating
the fields:

Validation Status field:

For Data Type choose Text

Field Label: Email Validation Status
Length: 100

Field Name: Email_Validation_Status

Validation Timestamp field:

For Data Type choose Date/Time.

Field Label: Email Validation Timestamp
Field Name: Email_Validation_Timestamp

Note: We advise aligning Field Label and Field Name naming conventions with the respective email
configuration for the required Object. For example change “Email” to “Contact Email" or "Web Email”
depending on the required email configuration.

You may optionally store additional data pertaining to the email verification process which can be used to
further enhance and improve decision making and email effectiveness.

e Validation Message — Descriptive message pertaining to the deliverability of the email address. (Field
type: Text or Text Area, Field length: 100 characters).

e Certainty — Six codes that have various meanings around the deliverability of an email address. For a
detailed explanation of the certainties please visit the email verification section of the User Guide.
(Field type: Text, Field length: 35 characters).

e Suggestion — Potential suggested email address returned by the service, this should not be
considered the corrected email however can be considered a suggested email to be utilized and
should be submitted for email verification. (Field type: Text or Text Area, Field length: 255
characters).




Phone Custom Fields

Note: You should only follow these steps if you are going to use Phone Verification.

You need to repeat steps 1-6 from the Address custom fields section for each Phone touchpoint in order to
create the Validation Status and Validation Timestamp custom fields for Phone. Please use the below values
when creating the fields:

For the Validation Status field:

For Data Type choose Text.

Field Label: Phone Validation Status
Length: 100

Field Name: Phone_Validation_Status

For the Validation Timestamp field:

For Data Type choose Date/Time.

Field Label: Phone Validation Timestamp
Field Name: Phone_Validation_Timestamp

Note: We advise aligning Field Label and Field Name naming conventions with the respective phone
configuration for the required Object. For example change “Phone" to “Mobile” or “Home Phone" depending
on the required phone configuration.

You may optionally store additional data pertaining to the phone verification process which can be used to
further enhance and improve decision making.

e Validation Message — Descriptive message pertaining to the deliverability of the phone number.
(Field type: Text or Text Area, Field length: 100 characters).

e Certainty — Six codes that have various meanings around the deliverability of a phone number. For a
detailed explanation of the certainties please review Advanced Settings for Phone. (Field type: Text,
Field length: 35 characters).

e CountryName - Name of the country relating to the phone number, e.g. "United Kingdom"(Field
type: Text, Field length: 100 characters).

e CountryCode - Home country relating to the phone number, e.g. "44" (Field type: Text, Field length: 2
characters).

e IsRoaming - Indicates whether the number is currently outside of the country where it is registered.
(Field type: Text, Field length: 6 characters).

¢ MCCMNC - Mobile Country Code (MCC) and Mobile Network Code (MNC). (Field type: Text, Field
length: 10 characters).

e Number - Phone number supplied. (Field type: Text, Field length: 20 characters)

e OperatorName - Company name of the MSISDN Operator, e.g. "T-Mobile" (Field type: Text, Field
length: 100 characters).

10



Phone Type - Type of the submitted phone number, e.g. "LandLine”, "Mobile" (Field type: Text, Field
length: 10 characters).

PortedCountryCode - Home country code from which the mobile number is ported. (Field type: Text,
Field length: 2 characters).

PortedCountryName - Name of the country from which the mobile number is ported. (Field type:
Text, Field length: 100 characters).

PortedOperatorName - Operator from which the mobile number is ported. (Field type: Text, Field
length: 100 characters).

Result Code - Status code of the submitted phone (e.g. 3). (Field type: Text, Field length: 10
characters).

RoamingCountryCode - The prefix of the country the number is currently located in. (Field type:
Text, Field length: 2 characters).

RoamingNetworkName - The network name of the Mobile Switching Centre that the number is
currently connected to. (Field type: Text, Field length: 100 characters).

RoamingNetworkPrefix - The prefix of the Mobile Switching Centre the number is currently
connected to. (Field type: Text, Field length: 20 characters).

ValidatedPhoneNumber - Verified number in international format without the leading "+", e.g.
"447123456789" (Field type: Text, Field length: 20 characters).

11



Add Validation Status and Validation Timestamp
Custom Fields to Your Object Layouts

After you have created your custom fields, the next step is to add the fields to your Page layouts.

1. Go to Setup = Objects and Fields > Object Manager = {Object Name} (e.g. Account).
2. Navigate to the Page Layouts section and select the layout for which EDQ service is required.

« Page Layouts (4) New Page Layout Assignment
PAGE LAYOUT MAME CREATED BY MODIFIED BY
Account (Marketing) Layout Kristina Peycheva, 5/15/2017, 2:48 PM Kristina Peycheva, 5/15/2017, 4:06 PM v
Account Layout Kristina Peycheva, 5/15/2017, 2:48 PM Kristina Peycheva, 5/15/2017, 4:06 PM -
Account (Support) Layout Kristina Peycheva, 5/15/2017, 2:48 PM Kristina Peycheva, 5/15/2017, 4:06 PM -
Account (Sales) Layout Kristina Peycheva, 5/15/2017, 2:48 PM Kristina Peycheva, 5/15/2017, 4:06 PM -

3. Drag and drop the EDQ fields from the top palette to the Address Information section of the page
layout.

There are two EDQ fields for each address type that should be added to the layout:

e {type} Validation Status
e {type} Validation Timestamp

We recommend these fields be placed below the corresponding address lines on the page layout as per the
screenshot below:

oy SETUP.

Object Manager

save v || Quick Save | Preview As...v | Cancel| | £\ Undo | /. Redo | [ Layout Properties -
ount Billing Address. Fax Phone Type
iy Deseription e Mumber of Locations || Rating Upselt Opportunty
Hotive Customer Priority Lust Modified By Ownersbip Shipping Address [SIC Dessripbion | Tieker Syl Wiebsite
[
e
Pt P
e e B
B U —y
hietion s
‘Shipping Address _ Suite 300, The Landmart @ One Market CEN
T
=
!

12



Integrate Global Data Quality into Your Salesforce
Pages

There are two implementation methods you can use to integrate the solution as outlined in the table below.
Select the required method and apply the associated steps:

Method Details
1. Dynamic Page Override Implementation Method (Recommended) Page 13
2. Non-dynamic Page Override Implementation Method Page 19

Dynamic Page Override Implementation Method
(Recommended)

Note: Overriding standard buttons and links changes the meaning of the Salesforce URL and also changes
any requests to that URL (e.g. a Salesforce page, a browser shortcut or an external system).

You can use the Visualforce pages supplied by Experian Data Quality to override the New and Edit buttons on
your respective Objects. These pages dynamically mimic your page layouts and include Experian Data Quality
contact verification services within the dynamically created pages.

If you do not wish to override the New and Edit pages, follow the “Non-page override implementation
method”.

Create Apex Controller and Dynamic Visualforce Page

Note: EDQ provides default implementations of the Apex Controller and a Visualforce Page which can be
used for the Accounts, Contacts, Contracts and Leads standard objects, if you wish to utilize EDQ service
within these object(s) you can go straight to “Override the “New” and “Edit” buttons on your Object
layout” section. If you require EDQ service within any other standard object or custom objects, please
follow the steps below.
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Create Apex Controller (Custom Objects Only)

1. Go to Setup > Custom Code > Apex Classes.

~

o * SETUP

Apex Classes

Setup Home
Apex Classes Help for this Page ()
ADMINISTRATION

Force.com Apex Code is an obisct oriented programming language that allows developers to develop on-demand business on the Force.com platform

> Users

Percent of Apex Used: 0%
> Data You sre curently using 0 charscters of Apex Code (exdluding comments and @isTest annotated dasses) in your organizstion. out of an allowed limit of 3,000,000 characters. Note that
the amount in use includes both Apex Classes and Triggers defined in your organization.

> Emall

Estimate your izstion's code coverage | i

PLATFORM TOOLS
Compile all classes | i

> Apps View: Create New View

Feature Settings AlB|C|D|E|F|[G|H|I/J|K[L|M|N|O|P|@|R|S5|T|U|V|W|X|Y | Z| Other AN

Developer Console | | New | | Generate from WSDL | | Run All Tests | | Schedule Apex

‘Objects and Flelds

Name T Namespace Prefix Api Version Status Size Without Comments Last Modified By Has Trace Flags
Process Automatlon

No records to display.

User Interface

s Custom Code
APL

I Apex Classes

2. Click on New and enter the following code replacing {Object name} with the name of your Object.

public with sharing class {Object Name}DataQualityExt {
public {Object Name}DataQualityExt(ApexPages.StandardController stdController) {
this.PageRenderer = new EDQ.PageRenderer(stdController, '{Object API Name}'),

}
public EDQ.PageRenderer PageRenderer { get; private set; }

* SETUP

Apex Classes

Apex Class Help for this Page 0

Apex Class Edit Save | | Quick Save | | Cancel

Apex Class = Version Settings

Q = 4@ & A a
1 |public with sharing class {Account}DatafualitvExt {
2 public {Account}DataQualityExt (ApexPages.StandardController stdController) {
this.PageRenderer = new EDQ.PageRenderer (stdController, '{Account}'):
4 }
public EDQ.PageRenderer PageRenderer { get; private set; }

3. Click on Save.

Create Dynamic Visualforce Page (Custom Objects Only)

1. Go to Setup = Custom Code - Visualforce Pages and click the New button.
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2.

3.

Q C

Setup Home

ADMINISTRATION
> Users
> Data

» Emall

$ SETUP

Visualforce Pages

Visualforce Pages Help

Visualforce Pages provide a robust and easy to use mechanism to create new and exciting user experiences for your application or to enhance existing applications to optimize your users’ produt

View: Craste New View

AlB|G|D|E[F|G|[H|I[J[K|L|M|N|O|P|@|R|S|T|U|V|W|X|Y

Developer Cansale | | New

Action Label Hame Namespace Prefix Api Version Description Created By Alias Created Date Last Modified By Alias Last Mot
PLATFORM TOOLS
Edit | Del | Security AccountDynamicPege AccountDynsmicPage 270 KPeyc 180017y peve 161052
“ 03:52
> Apps
16/05/2017
Edit | Del | S¢ [ Contact 270 KPey KPey 1600572/
3 Feature Settings it el seaunty [ [B] = 5 = < 08:52 <
16/05/2017
. £ =y il
, Objects and Flelds Edit | Del | Security |[{4]  ContractDynsmicPsge CentraciDynamicPage 270 KPsye 0852 KPsye 18/05/2|

For Label and Name enter the name of the Apex Controller you created in the previous step.

Label: {Object Name}DynamicPage
Name: {Object Name}DynamicPage

In the Visualforce Markup tab enter the following code replacing {Object name} with the name of your

Object, {Object APl name} with the APl name of your Object (including the package prefix if there is one)

and {Object’s Controller Name} with the name of the controller:

<apex:page standardController="{Object API Name}" tabStyle="{Object API Name}"
extensions="{0Object’s controller extension name you created on step 2}"

action="{!PageRenderer.RedirectToStandardPageInCaseOfAnError}" applybodytag="false">

<body id="lightningStyle">
<apex:stylesheet value="{!URLFOR($Resource.EDQ__DynamicPageCss)}" />
<apex:includeScript value="{! URLFOR($Resource.EDQ__EDQAssets,
'/scripts/EDQScripts.js')}"/>
<script type="text/javascript">
if(ForceUI.isSalesforcel()){
document.write
('<link rel="stylesheet" type="text/css" href="{!urlfor($Resource.EDQ__EDQAssets,
"styles/LightningCss.css')}" />');
}

</script>

<apex:form styleClass="edq-{!PageRenderer.SObjectName}" id="experianForm">
<apex:pageMessages id="messages" />

<apex:sectionheader title="{!$0bjectType.{Object API name}.label} Edit"
subtitle="{!IF(ISNULL({Object API name}.Name), 'New {Object Name}', {Object API
name}.Name)}"/>

<EDQ:DuplicatesTable duplicates="{!PageRenderer.Duplicates}"”
pagerenderer="{!PageRenderer}" />

<div style="display:none"> <apex:inputField value="{!{Object API
Name}.Id}" /> </div>

<apex:dynamicComponent componentValue="{!PageRenderer.PageBody}" />
<apex:outputPanel id="experianDataQuality">

<EDQ:DataQualityDynamic PageRenderer="{!PageRenderer}" />
</apex:outputPanel>

<EDQ:DataQualityDynamicScripts PageRenderer="{!PageRenderer}" />
</apex:form>
</body>
</apex:page>
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Page Information 1 = Required Information

tebel  JAccountDynamicPage
Name [ AccountDynamicPage

Available for Lightning Experience, Lightning
mmunities, and the mabile app.

Require CSRF protaction on GET requests

Visualforce Markup | Version Settings

Q=+ 4@ A

1 [<apex:page standardController="Account” tabStyle="Account” extensions="EDQ.AccountDataQualityExt” action="{! _RedirectToSt InCaseOfAnError}” applybodytag="false"> -
2 <body id="lightningStyle">

3 <apex:stylesheet value="{!URLFOR($Resource.EDQ_ DynamicPageCss)}" />

4 <apex:includeScript value="{! URLFOR($Resource.EDQ_ EDQAssets, '/scripts/EDQScripts.js’)}"/>

5 <script type="text/javascript™>

if(Forceul.issalesforce1()){

document.write(’<link rel="stylesheet” type="text/css” href="{lurlfor($Resource.EDQ_EDQAssets, 'styles/LightningCss.css')}" />');
1
</script>

11 <apex:form styleClass="edq-{!PageRenderer.SObjectName}" id="experianForm">
12 <apex:pageMessages id="messages" />

14 <apex:sectionheader title="{!$0ObjectType.Account.label} Edit" subtitle="{!IF(ISNULL(Account.Name), 'New Account', Account.Name)}"/>
<div style="display:none™> <apex:inputField value="{!Account.Id}" /> </div>

<apex:dynamicComponent componentValue="{!PageRenderer.PageBody}" />
<apex:outputPanel id="experianDataQuality”>

<EDQ:DataQualityDynamic PageRenderer="{!PageRenderer}" />
</apex:ioutputPanel>

<EDQ:DataQualityDynamicScripts PageRenderer="{!PageRenderer}" />
</apex: form>
</body>
26 |</apex:page>

Example:

If you would like to create the page for the standard object “Order” you need to replace {Object
Name} with “Order”. If you would like to create the page for a custom object named “Test” you need
to replace the {Object Name} with "Test".

If you would like to create the page for the standard object “Order” you need to replace {Object API
Name} with “Order”. If you would like to create the page for a custom object named “Test” which
comes from a managed package named “EDQ" you need to replace the {Object APl Name} with
“"EDQ__Test__c".

Note: If you're utilizing Salesforce1 you need to check the “Available for Salesforce mobile apps and
Lightning Pages” option in the newly created custom visual force page.

You may find the exact {Object Name} and {Object APl Name} by going to Setup Objects and Fields > Object
Manager - {Object Name} (e.g. Account). > Details.

4. Click on Save. The next step is overriding the “New" and "Edit" buttons.

Override the “New” and “Edit” Buttons on Your Object Layout

Note: Overriding your standard “Edit"” button will disable the inline editing of the fields in your Object's
Detail page. If you wish to have this functionality enabled please see the workaround in the
“Troubleshooting” section.

1. Go to Setup > Objects and Fields > Object Manager -> {Object Name} (e.g. Account).

2. Navigate to the Buttons, Links, and Actions section.
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Details

Fields & Relationships
Page Layouts

Lightning Record Pages
Buttons, Links, and Actions
Compact Layouts
Object Limits

Record Types

Related Lookup Filters
Search Layouts
Triggers

Validation Rules

Buttons, Links, and Actions

15 Items, Sorted by Label

LABEL

Accounts Tab

Add to Call List

NAME DESCRIPTION  TYPE

Tab

CreateCallList

Q F : New Action

CONTENT SOURCE

Standard Salesforce.com Page

Standard Salesforce.com Page

Billing Billing Detail Page Link URL

Check Integration Status XClean Standard Salesforce.com Page
Clean ListClean Standard Salesforce.com Page
Delete Delete Standard Salesforce.com Page
Edit Edit Standard Salesforce.com Page

New Button or Link

OVERRIDDEN

3. Navigate to the New button and click on the arrow. Click the Edit link. You will be redirected to the
Override Properties page.

Related Lookup Filters
Search Layouts
Triggers

Validation Rules

Hierarchy Columns

Delete Delete Standard Salesforce.com Page
Edit Edit Standard Salesforce.com Page
Email SendEmail Standard Salesforce.com Page

Get More Accounts

List

Validate Billing Address

DataDotComGetAccountsMultiAddAction

List

Validate_Billing_Address

Detail Page Button

Standard Salesforce.com Page

Standard Salesforce.com Page

Standard Salesforce com Page

OnClick JavaScript

4. Select the Visualforce Page radio button and make sure to select the {Object Name}DynamicPage page

from the drop down list.
Override Properties Save| | Cancel
Label  New
Name  New
Default  Standard Salesforce.com Page
Owerride With O No Override (use default)
O Lightning Compenent Bundle
(@) Visualforce Page ‘ --None-—- |V |
Comment --None--

5. Click Save.

AccountDetailView [AccountDetailView]

Redirect to the Experian data quality page [EDQ__AccountRedirectToDataQualityPage]
Redirect to the Experian data quality page [AccountRedirectToDataQualityPage]

Sawve | |Cancel

Note: Be careful not to select the “Redirect to Experian data quality page” VF page which appears below

the dynamic visual

force page. The “Redirect to Experian data quality page” is only used for the non-page

override method which requires you to add it to your page layout. You must not select it when overriding

your buttons.

After saving you will notice that a tick (¥) appears in the tick box within the overridden column for the button

you chose to override.
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Repeat the steps above for the Edit button if EDQ service is also required for Edit pages.

Add Your Salesforce Instance URL and the EDQ Endpoint to The Remote Site
Settings

In order for the solution to be able to gather your page layout information you must create a “Remote Site”
for your specific Salesforce server. To do that follow the steps below:

1. Go to Setup > Settings > Security > Remote Site Settings and click the New Remote Site button.

Setup Home

All Remote Sites B
Lightning Experience
Below is the list of Web addresses that your organization can invoke from salesforce.com. To add another Web address, click New Remote Site.
ADMINISTRATION View: Create New View
> Users Alp|c|o|E|F|G[H|I|J|K|L|M|N|O|P|Q|R|S|T|U|V|W|X|Y|Z|Cther |l
Hew Remote Site
> Data —_—
Action Remote Site Name * Namespace Prefic  Remote Site URL Active CreatedBy  Created Date Last Modified By  Last Modified Date
> Email Edit | Del ApexDeviet _ hitp:iivewew apexdevnet com v Mitev, Kos 24/04/2017 14:22 Mitev, Kos 24/04/2017 14:22
Edit| Del % EDQ EDQ https:i/sfvS. online gas.com v Mitev, Kos 104052017 12:13 Mitev, Kos 10/05/2017 12:13

PLATFORM TOOLS

FrA# | Mal Raleafarre httne-lien1 asleafarrae rnm wr Mitew Kna NTINRINAT 1024 Mitew Kna NTIRINT 1074

2. Enter the following:

Remote Site Name: Salesforce
Remote Site URL: Insert your Salesforce domain (e.g. https://eu5.salesforce.com).

Remote Site Edit Help for this Page (@)

Enter the URL for the remote site. All s-controls, JavaScript OnClick commands in custom buttons, Apex, and AJAX proxy calls can access this Web address from salesforce. com.

Remote Site Edit Save | | Save & New | | Cancel

Remote Site Name I|Sa|eSfOrCE

Remote Site URL I|htn:|s:ﬂeu 11.lightning. force. com
Disable Protocol Security I:l i

Description

Retive

Save | | Save & Mew | | Cancel

Note: If you use a custom salesforce.com domain (My Domain is enabled) you will need to find the
Salesforce instance which hosts your organization. The pattern is the following:

https://{myDomain}--c.visualforce.com (for custom Visualforce Pages)
https://{myDomain}--edq.visualforce.com (for Visualforce Pages that come from the EDQ package)
where {myDomain} should be replaced with the domain name from Setup->Quick Find->My Domain.

Please note that {myDomain} should be replaced with only the part before the first dot, (that means that in the
above example, we should only take johnsmith,).
And the URLs for the Remote Site Settings should look similar to this:

https://johnsmith--c.visualforce.com
https://johnsmith--edq.visualforce.com
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3. Click Save to add the URL into your Remote sites.

Repeat the steps 1-3 for the EDQ Endpoint using the below details:
Remote Site Name: CustomSObjectTypelD

Remote Site URL: https://sfv5.online.qas.com

Non-page Override Implementation Method

If you do not wish to override your standard buttons you can manually perform the necessary steps to
configure the EDQ service in an alternative way. Depending on the validation workflow you wish to use, follow
the steps below specific to the required validation mode.

For further information regarding the validation modes visit page 39 for Address validation modes, page 48
for Email and page 55 for Phone validation modes.

Interactive Address or Email / Phone Verification - Non-page Override
Implementation Method

Note: You should only follow this step if you are utilizing Interactive address / email / phone verification
and you chose NOT to override the "New” and “Edit” buttons as described in the previous step.

For Interactive verification mode, a Visualforce page is added to the Page Layouts which require EDQ service,
on Save the Visualforce page redirects the user to the EDQ Interactive Verification Page. Depending on which
object you wish to configure, you may also need to create the EDQ Interactive Verification Page. See note
below.

Note: EDQ provides default implementations of the two Visualforce pages which can be used for Interactive
verification mode within Accounts, Contacts, Contracts and Leads standard objects. If you wish to utilize
Interactive verification mode within these object(s) you can go straight to Add the
“EDQRedirectToDataQualityPage” Visualforce page to your Object layout section (page 24).

If you require Interactive verification mode within any other standard object or custom objects, please
follow the steps below.

Create the Redirect Visualforce Page

1. Go to Setup - Custom Code - Visualforce Pages. Click the New button.

A

o * SETUP

Visualforce Pages

A

Visualforce Pages Helpfor tis Fege @)

Setup Home

ADMINISTRATION
Visualforce Pages provide a robust and sasy to use mechanism to create new and exciting user experiences for your appication or to enhance existing applcations to optimize your users’ productivy.

View: Creste New View

> Users

> Data
AlB[C|DIE[F|G H[I|J/KIL M N|e|[P @|R[S|T|U[VIW|x| Y| Z| Other M

> Emall Developer Console | | Hew

Action Label Hame Mamespace Prefix Api Version Description Created By Alias Created Date  Last Modified By Alias Last Modified Date +
PLATFORM TOOLS
Edit| Del | Security | (8] e 270 KPeve égmszfzow KPeve 16/06/2017 08:53

> Apps
16/05/2017

Edit | Del | Security @ "ag1 ContadtD "sge 270 KP: 08:52

P 16/05(2017 08:53

5 Feature Settings

16/05/2017
08:52

3 Obects and Flelds Eait| Del | Security |[{f]  ContiactD 2! = age 270 1800512017 08:52

18/08/2017
08:52

> Process Automation Edit| Del | Security [[#] L icPag L icPag 270 181052017 08:53

5
il
&

16/08/2017
» UserInterface Edit| Del | Security |[[f]  Account Dsts Quslity AccountDataQuality 330 Peyc osE2 KPeyc 18/05/2017 08:52

3

2. Enter the following values:
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file:///E:/QAS/CASalesForce/branches/SalesForceV5/development/Documentation/Installation%20and%20Configuration%20Guide/EDQRedirectToDataQualityPa_1%23_Add_the_

Label: {Object Name} Redirect to Data Quality Page
Name: {Object Name}RedirectToDataQualityPage

3. In the Visualforce Markup tab enter the following code:

<apex:page showHeader="false" sidebar="false"
standardController="{Object API Name}"

extensions="EDQ.RedirectToDataQualityPageController”
action="{!Execute}">

<EDQ:RedirectToDataQualityPage

RedirectToDataQualityPage="{!RedirectToDataQualityPage}"

DataQualityPageUrl="{!DataQualityPageUrl}" />

</apex:page>

Replace {Object API Name} with the APl name of your object. If your Object comes from a managed package

make sure that you replace {Object APl Name} with the full Object APl name including the object’s prefix and
suffix.

* SETUP

Visualforce Pages

Visualforce Page

Help for this Page 0

Page Edit Save | | Quick Save | | Cancel | |Where is this used?| | Component Reference | | Preview

Page Information 1 = Required Information

Label | direct To Data Quality Page
Mame  |nedirectToDataQualityPage

Description

Byailable for Salesforce mobile I:‘
apps and Lightning Pages

Require CSRF protection on GET [ ]
requests

Visualforce Markup = Version Settings

Q = 4 & A a

1 |[«xapex:page showHeader="falze™ sidebar="false"

standardController="Account” extensions="EDR.RedirectToDatafualityPageController”™
action="{!Execute}">
4 [<EDQ:RedirectToDataQualityPage RedirectToData(ualityPage="{!RedirectToDataQualityPage}"™

5 DataQualityPageUrl="{!DataQualityPageUrl}™ />
& |[«fapex:page>

Example:

If you would like to create the page for the standard object “Order” you need to replace {Object Name} with

“Order”. If you would like to create the page for a custom object named “Test” you need to replace the
{Object Name} with “Test".

If you would like to create the page for the standard object “Order” you need to replace {Object APl Name}
with “Order”. If you would like to create the page for a custom object named “Test” which comes from a
managed package named "EDQ" you need to replace the {Object APl Name} with "EDQ__Test__c".

You may find the exact {Object Name} and {Object APl Name} by going to Setup - Objects and Fields >
Object Manager. Select your object to navigate to the Details section.

5. After you created your Visualforce page click Save.
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Create the Experian Data Quality Visualforce Page

Repeat steps 1-3 from the Create the Redirect Visualforce Page section using the values below:

Label: {Object Name} Data Quality
Name: {Object Name}DataQuality

And enter the following code:

<apex:page sidebar="false" tabStyle="{Object API Name}" showHeader="true"
controller="EDQ.DataQualityController">

<apex:form >

<EDQ:DataQuality DataQualityClient="{!DataQualityClient}"
ValidateSingleResultAction="{!DataQualityClient.RefineSelectedMatch}"
ContinueValidationAction="{!DataQualityClient.Next}" />
<EDQ:DataQualityTriggerAsync ExecuteValidationAction="{!Execute}" />
</apex:form></apex:page>

Replace {Object APl Name} with the APl name of your object. If your Object comes from a managed package
make sure that you replace {Object APl Name} with the full Object APl name including the object’s prefix and

suffix.

Page Edit Save | Quick Save | [ Cancel | | Where is ths used?| | Component Reference | | Preview

Page Information

Label  Jaccount Data Quality
Name  [accountbataquality

Description

Ausilsble for Salesforce mobile spps snd Lightning Fages [ ]
Require CSRF profection on GET requests [ ]

Visualforce Markup | Version Settings.

1 = Required Information

A 4+ 6 4 A

1 [<capex:page sidebar=rfalse” tabStyle="Account|' showHeader="true" controller="EDQ.DataQualityController™>
2 |<apex:form >
3 Quality DataQualityClient="{!DataQual:

aQualicyT: lidationk

ion="{ !Execute}” />

S |</apex: form></apex:page>

Click Save.

ient}" ValidateSingleResultAction="{!DataQualityClient ineSe! }" ContinueValidationAction="{'DataQualityClient.Next}" />

Add the “EDQRedirectToDataQualityPage” Visualforce Page to Your Object Layout

1. Go to Setup > Objects and Fields > Object Manager > {Object Name} (e.g. Account).

2. Navigate to the Page Layouts section. Click on the arrow next to the desired page layout which you

would like to edit and click the Edit link.

v Page Layouts (4) New Page Layout Asslgnment
PAGE LAYOUT NAME CREATED BY MODIFIED BY
Account (Marketing) Layout Krlstina Peycheva, 5/15/2017, 2:48 PM Krlstina Peycheva, 5/15/2017, 4:06 PM -
Account Layout Kristina Peycheva, 5/15/2017, 2:48 PM Kristina Peycheva, 5/16/2017, 7:53 AM -
Edit
Account (Support) Layout Kristina Peycheva, 5/15/2017, 2:48 PM Kristina Peycheva, 5/15/2017, 4:06 PM
Delete
Account (Sales) Layout Kristina Peycheva, 5/15/2017, 2:48 PM Kristina Peycheva, 5/15/2017, 4:06 PM -

3. Select the Visualforce Pages item from the list on the left side of the Account layout table.
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4. Drag the {Object Name}RedirectToDataQualityPage component somewhere on the page layout. Once it
is placed, hover over it and click on the Properties icon which looks like a wrench (™) positioned in the
upper right corner of the component.

* SETUP
Object Manager
Save v || Quick Save || Preview As...v || Cancel | | @ Undo | /3 Redo Layout Properties ~
Custom Links A (@, Quick Find| Pg= Name |=
Quick Actions = -
Salesforce 2 Lightning + Section Redirect to the E... |
Actions +F] Blank Space
Expanded Lockups AccountDetailView
Relsted Lists AccountDynamicPage
Report Charts
Visualforce Pages L

Account Detail Standard Buttors
Edit | | Changg Owner | | Change Record Type | | Delete | | Sharing | | Include Offline | | 5end an Email | | Check Integration Status

# Account Information [Header visible on edit only)

Rating  Sample Rating

VF Redirect to the Experian data quality page

Becount Owner  Sample User Fhone  1-415-565-1212

% ® Account Mame  Sample Account Name Fax  1-415-555-1212

5. A pop up with the Visualforce Page Properties will appear. Enter:
Width (in pixels or %): 0%
Height (in pixels): 0
Show scrollbars and Show label should be left unchecked.

Visualforce Page Properties x
Width (in pixels or %) [0% |
Height (in pixels) I 0 I

Show scrollbars =

Show label m

oK || cancel

6. Click OK and then click Save.

NB! When using Interactive Address or Email / Phone Verification — Non-page Override Implementation
Method in Lightning interface, for the object in which the verification service is installed, please configure
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https://help.salesforce.com/articleView?id=000313609&type=1&mode=1

Rapid Search Address or Email / Phone Verification — Enforced Usage — Non-
page Override Implementation Method

Note: You should only follow the steps described in this section if you are utilizing Rapid Search address or

inline email / phone verification and you chose NOT to override the “New” and “Edit” buttons as described
in the previous step.

Enforced usage enables Rapid Search address verification and / or email and phone verification services to be

invoked automatically ensuring contact data verification services are utilized without relying on end user
interaction. On save if the address, email or phone number does not contain a Verified status or has been
edited, verification services will be automatically invoked.

To enable enforced usage when using Rapid Search address, email / phone verification (non-page override)
follow the steps below
Create the Redirect Visualforce Page

1. Go to Setup - Custom code > Visualforce Pages. Click the New button at the top of the Visualforce
page.

SETUP
& Visualforce Pages

Visualforce Pages Help for this Page @)

Vigualforce Pages provide a robust and easy to use mechanism to create new and exciting user experiences for your application or te enhance existing applications to optimize your users” productivity.

View: Create New View

A|B|C D EF|G|H|IJ|/KLMNO|P QR S T|U|V W X Y Z| Other Al

Developer Console | | New

Action Label Name Namespace Prefix Api Version Description Created By Alias Created Date  Last Modified By Alias Last Modified Date +

Edit | Del | Security | (2] AccountD g AccountD =g 270 KMite f‘g‘_";j"zﬂw KMite 17/05(2017 12:32
28/02/2017

Edit | Del | Security | (2] ContactD: icPag ContactD ag 270 KMite 122s KMite 17M05/2017 12:32
28/02/2017

Edit | Del | Security | 2] LeadDynsmicFsge LeadCynemicPage 270 KMite 23 KMite 17/05(2017 12:32

Friit | D&l | Serrite | A7 an Custom Object NevanCistatmOhisrtDvnamirPans a0 drhin 21022017 Khite ATMRZNAT 1737

2. Enter the following values:

Label: {Object Name} Enforced Usage
Name: {Object Name}EnforcedUsage

3. In the Visualforce Markup tab enter the code:

<apex:page showHeader="false" sidebar="false"
standardController="{Object API Name}"

extensions="EDQ.DataQualityEnforcedUsageController"
action="{!Execute}">

<EDQ:DataQualityDetailPageScripts Urls="{!Urls}"
DetailPageUrl="{!DetailPageUrl}"
DataQualityEnforcedUsageData="{!EnforcedUsageData}"
EnableEnforcedUsage="true"
IsCalledFromDetailPageOverride="false" />
</apex:page>
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4. Replace {Object APl Name} with the APl name of your object (e.g Account). If your Object comes from a

managed package make sure that you replace {Object API Name} with the full Object APl name including
the object’s prefix and suffix.

$ SETUP

Viisualforce Pages

Visualforce Page

Help for this Page 0

Page Edit Save | | Quick Save | | Cancel | | Where is this used?| | Component Reference | | Preview

Page Information 1 = Required Information

Label  |laccount Enforced Usage
Mame  |laccountEnforcedUsage

Description

Available for Salesforce mobile I:‘
apps and Lightning Pages

Require CSRF protection on GET ]
requests

Visualforce Markup = Version Settings

Q = 4@ & A a

1 [«xapex:page showHeader="false"™ sidebar="false"

2 standardController="Account™ extensions="EDQ.DatafualityEnforcedUsageController™
3 action="{!Execute}">

<EDQ:DataQualityDetailPageScripts Urls=“{!Urls}“|
DetailPageUrl="{!DetailPageUrl}™
DatafQualityvEnforcedUsageData="{!EnforcedUsageDatal™
EnableEnforcedlUsage="true"
= I=zCalledFromDetail PageOverride="fal=se" />
10 |«fapex:page>

Example:
If you would like to create the page for the standard object “Order” you need to replace {Object APl Name}

with “Order”. If you would like to create the page for a custom object named “Test” which comes from a
managed package named “EDQ" you need to replace the {Object API Name} with “EDQ__Test_ c".

You may find the exact {Object Name} and {Object APl Name} by going to Setup > Objects and Fields >
Object Manager. Select your object to navigate to the Details section.

I Search All Setup J Custom Object Help for this Page @
Test (Managed)
Expand All | Collapse All §
| + This Custom Object Definition is managed, meaning that you may only edit certain attributes. Display More Information ‘
Salesforce1 Setup
Standard Fields (4] | Custom Fields & (171 | Validation Rules[0] | Page Layouts[2] | Field Sets[0] | CompactLayouts[1] | Search Layouts[s] | Buttons. Links. and Actions (8] |
Force.com Home Record Types [0 | Apex Sharing Reasons [J] | Apex Sharing R [01 | Object Limits [10]
System Overview Custom Object Definition Detail Edit
Singular Label Test Description
Personal Setup Plural Label  Test Enable Reports
. Object Name  Test Track Activities
*/ My Personal Information
+) Email Namespace Prefix EDC_Test Allow in Chatter Groups
») Import APIName EDQ Test c Allow Sharing v
+| Desktop Integration Allow Bulk API Access ¥
v

My Connected Data Allow Streaming API Access v

Track Field History

5. After you created your Visualforce page click Save.

Add the “{Object Name}EnforceUsage” Visualforce Page to Your Object Layout

1. Go to Objects and Fields > Object manager > {Object Name} (e.g. Account).
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2. Navigate to the Page Layouts section. Click on the arrow next to the desired page layout which you
would like to edit and click the Edit link.

3. Select the Edit link next to your page layout.

4. Drag the {Object Name}EnforceUsage page somewhere on the page layout. Once it is placed, hover over
it and click on the Properties icon which looks like a wrench (™) positioned in the upper right corner of
the component.

SETUP
& Object Manager

Save ¥ | Quick 3ave | Preview As...¥ ||Cancel| | Undo| 7} Redo Layout Properties

Custom Links ~ | @, auickFind| Fage Name | =
Quick Actions

Salesforce1 & Lightning i iecton o e
Adlions +F]Blank Space BAccount Enforced ...
Expanded Lockups AecountDetailView nedirm/m’m E..
Related Lists AccountDynamicPage Reglifect to the E...
Report Charts

Visualforce Pages W

# Account Information [Header visible on edjj-nly)

Phone  1-415-555-1212

VF Account Enforced Usage

5. A pop up with the Visualforce Page Properties will appear. Enter:
Width (in pixels or %): 0%
Height (in pixels): 0
Show scrollbars and Show label should be left unchecked.

Visualforce Page Properties x
Width (in pixels or %) [ 0% ]
Height (in pixels) I 0 ]

Show scrollbars =

Show label =

OK | ~ Cancel

6. Click OK and then click Save.

NB! When using Rapid Search Address or Email / Phone Verification — Enforced Usage — Non-page Override
Implementation Method in Lightning interface, for the object in which the verification service is installed,
please configure the default tab shown to be ‘Details’ when you open a record. More information on how to
configure this can be found here.
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Global Intuitive Address Verification — Non-page Override Implementation
Method

Note: You should only follow the steps described in this section if you are utilizing Global Intuitive address

verification and you chose NOT to override the “New” and “Edit” buttons.
There are two non-page override workflows supported by the Experian Data Quality.

Utilize Global Intuitive Using an Action Button

Note: You should have configured the Object for which you would like to utilize the Global Intuitive
Address verification described in the EDQ Administration Settings.

1. Go to Setup - Custom Code - Apex Classes.

2. Click on New and enter the following code replacing {Object name} with the name of your Object.

public class {Object Name}NonPageOverrideExtension {
public {ObjectName}NonPageOverrideExtension(ApexPages.StandardController
stdController) {
PageRenderer = new EDQ.NonOverridePageRenderer(stdController, '{Object API
Name}', touchpointNames);

}

public EDQ.NonOverridePageRenderer PageRenderer {get; private set; }
private Set<string> touchpointNames = new Set<string> {};

SETUP
& Apex Classes

Apex Class Help for this Page 0
Apex Class Edit Save | |Quick Save | | Cancel

Apex Class = Version Settings

Q =/ @6 & A a
1 |public class {Cbject Namel}lNonPageOverrideExtension {
public {ObjectNamel}lNonPageOverrideExtension (ApexPages.S5tandardController stdController) {
PageRenderer = new EDQ.HNonOverridePageRenderer (stdController, “{Object API Name}’, touchpointName

}

public EDQ.HonOverridePageRenderer PageRenderer {get; private set; }
private Set<string> touchpointNames = new Set<string> {}:

Note: If you would like to utilize Global Intuitive only in specific touchpoints, fill the touchpointNames
collection with the touchpoint names you'd like to be displayed on the view. (eg. Billing Address, Shipping
Address).

Example:
private Set<string> touchpointNames = new Set<string> {‘Billing Address’, €‘Shipping

Address’};
If the touchpointNames collection is left empty, all configured for the current sObject will be available on

the view.

3. Click the Save button.
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4. Go to Setup > Custom code - Visualforce Pages. Click the New button at the top of the Visualforce
page to create a new Visualforce page.

5. In the Visualforce Markup tab enter the code:

<apex:page standardController="{Object API Name}" title="Experian Data Quality"
tabStyle="{Object API Name}" extensions="{Object’s controller extension name you
created on step 2}" applyHtmlTag="false" applyBodyTag="false" showHeader="false"
cache="false" showQuickActionVfHeader="false">
<body id="lightningStyle">
<apex:form id="experianForm" styleClass="edq-{!PageRenderer.SObjectName}
edgNonPageOverride">
<apex:outputpanel id="edgNonPageOverride" rendered="{!OR(NOT

PageRenderer.IsValidationCompleted, NOT PageRenderer.IsSalesforcel)}">

<apex:pagemessages id="messages" escape="false" />

<apex:dynamicComponent componentValue="{!PageRenderer.PageBody}" />

<edq:DataQualityNonPageOverride PageRenderer="{!PageRenderer}" />
</apex:outputpanel>
<edq:DataQualityNonPageOverrideScripts pagerenderer="{!PageRenderer}" />
</apex:form>
</body>
</apex:page>

6. Replace {Object APl Name} with the APl name of your object (e.g Account). If your Object comes from a

managed package make sure that you replace {Object APl Name} with the full Object APl name including

the object's prefix and suffix.

Note: Make sure the page is available for Lightning and Salesforce by checking the Available for
Salesforce mobile apps and Lightning Pages checkbox.

7. Click the Save button.

8. Go to Setup - Objects and Fields > Object manager > {Object Name} (e.g. Account).

9. Navigate to the Buttons, Links, and Actions section.

10. Click the New Action button.

11. Fill in the following information:

Action Type: Custom Visualforce

Visualforce Page: Your newly created Visualforce page enabled for Salesforce Lightning and Salesforce1

Height: 625px
Label: Edit Contact Details (or any meaningful name)
Name: Edit Contact Details (or any meaningful name)
12. Click the Save button.
13. Go to Objects and Fields > Object manager > {Object Name} (e.g. Account).

14. Navigate to the Page Layouts section. Click on the arrow next to the desired page layout which you
would like to edit and click the Edit link.

15. Navigate to the Salesforce1 and Lightning section and click on the Override to customize icon which
looks like a wrench (™) to customize the section.

16. From the selector at the top of the page select the Salesforce1 & Lightning Actions category and then
drag the Edit Contact Details action button on the page layout in the Salesforce1 and Lightning
Experience Actions section.
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17. Click the Save button.

Address Verification with Global Intuitive — Using Custom Page Tab

Note: You should have configured the Object for which you would like to utilize the Global Intuitive
Address verification described in the EDQ Administration Settings.

1. Go to Setup = Custom Code > Apex Classes.

2. Click on New and enter the following code replacing {Object name} with the name of your Object.

public class {Object Name}NonPageOverrideExtension {
public {ObjectName}NonPageOverrideExtension(ApexPages.StandardController
stdController) {
PageRenderer = new EDQ.NonOverridePageRenderer(stdController, '{Object API
Name}', touchpointNames);

}

public EDQ.NonOverridePageRenderer PageRenderer {get; private set; }
private Set<string> touchpointNames = new Set<string> {};

SETUP
Apex Classes

]

Apex Class Help for this Page @
Apex Class Edit Save | | Quick Save | | Cancel

Apex Class | Version Settings
-

QL S| H & A A
1l ([public class {Object Name}NonPageOverrideExtension {
2 public {ObjectNHame}NonPageOverrideExtension (ApexPages.StandardController stdController) {
3 PageRenderer = new EDQ.NonOverridePageRenderer (2tdController, ‘{0Object APT Namel}’, touchpc

4 }
public EDQ.NonOverridePageRenderer PageRenderer {get; private set; }
private Set<string> touchpointNames = new Set<string> {};

Note: If you would like to utilize Global Intuitive only in specific touchpoints, fill the touchpointNames
collection with the touchpoint names you'd like to be displayed on the view. (eg. Billing Address, Shipping
Address).

Example:

private Set<string> touchpointNames = new Set<string> {'Billing Address', 'Shipping
Address'};

If the touchpointNames collection is left empty, all configured for the current sObject will be available on

the view.

3. Click the Save button.

4. Go to Setup > Custom code - Visualforce Pages. Click the New button at the top of the Visualforce
page to create a new Visualforce page.

5. Enter the following values:

Label: {Object Name} Global Intuitive
Name: {Object Name}Globallntuitive
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6. In the Visualforce Markup tab enter the code:

<apex:page standardController="{Object API Name}" title="Experian Data Quality"
tabStyle="{Object API Name}" extensions="{Object’s controller extension name you
created on step 2}" applyHtmlTag="false" applyBodyTag="false" showHeader="false"
cache="false" showQuickActionVfHeader="false">
<body id="lightningStyle">
<apex:form id="experianForm" styleClass="edq-{!PageRenderer.SObjectName}
edgNonPageOverride">
<apex:outputpanel id="edgNonPageOverride" rendered="{!OR(NOT
PageRenderer.IsValidationCompleted, NOT PageRenderer.IsSalesforcel)}">
<apex:pagemessages id="messages" escape="false" />
<apex:dynamicComponent componentValue="{!PageRenderer.PageBody}" />
<edq:DataQualityNonPageOverride PageRenderer="{!PageRenderer}" />
</apex:outputpanel>
<apex:outputpanel id="edqMessageWrapper"
rendered="{!AND(PageRenderer.IsValidationCompleted, PageRenderer.IsSalesforcel)}"
styleClass="pbBody message-panel”>
<div class="{!IF(PageRenderer.IsCanceled, 'message message-cancel',
'message message-success')}">
{!PageRenderer.ConfirmationMessage}
</div>
<apex:commandbutton styleClass="edq-button left"
onclick="window.location.reload(true); return false;" value="Start a new validation™
/>
</apex:outputpanel>
<edq:DataQualityNonPageOverrideScripts pagerenderer="{!PageRenderer}" />
</apex:form>
</body>
</apex:page>

7. Replace {Object APl Name} with the APl name of your object (e.g Account). If your Object comes from a
managed package make sure that you replace {Object APl Name} with the full Object APl name including
the object's prefix and suffix.

Note: Make sure the page is available for Lightning and Salesforce1 by checking the Available for
Salesforce mobile apps and Lightning Pages checkbox.
8. Click the Save button.

9. Navigate to the object for which you would like to utilize the Global Intuitive non-page override
verification;

10. Open one of the existing records.

11. Navigate to Settings and click on Edit Page.

» Qe x- @262 ™
e

BY Sales Home Leads w Accounts W Contacts EDQ Setup

ACCOUNT Developer Consola
i Kristina Peycheva + Follow Check Integratlon Status | Change Recorc ol w
Edlt Page
Typa Phone Webslte Account Owner Industry Bllling Addrass
9 Kristina Peycheva £* Edit Object

DETAILS RELATED EDIT ACCOUNT DETAILS ACTIVITY CHATTER

12. Select the Tabs section within the page editor;
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im Lghtning App Bullder -

X & O Desktop ShrinkToView v @ Refrash
Lightning Components [ Page > Tabs
Q Default Tab
Detalls
* Standard (19)
Tabs
[E] actvities = G
Chattar i
a Chatter Feed ! Reted
Chatter Publisher 1, Edit Account Detalls
£ merust P
.
13. Click the Add Tab button from the right-hand pane.
14. Select the newly created tab and set it to Custom.
15. Provide the new tab a meaningful name, for example Edit Contact details.
O Desktop shrink To View v ¢ Refresh
Page > Tabs

Ikt St
1
| Mot e T e things mowing, add A 01 6 L8 g,

[Ip—
1

Tab Label

Custom v

Edlit Coptact Detalls

Done

16. Click the Done button.

17. Select the tabs section and then select the newly created tab.
18. Click the Add Component(s) here link.

19. Select Visualforce from the left-hand pane.

Default Tab

Detalls

Tabs

) Detalls

Tl Related

T, Edlt Account Detalls

T, Detalls

Add Tab

Acthvation...

20. Using the Visualforce Page Name dropdown on the right-hand pane, select the page you've created in

step 9 and increase its height.
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im Lghtning App Bullder

Lightning Components

* Standard (19)

Activitles
Chatter
Chatter Feed
Chatter Publisher
=| Fliter List
Flow
B Hinignts panen
Potentlal Duplicates
i1 Recent Items
0 Recommendatlons

. Record Detall

Related List
g Related Lists

Related Record
| Report Chart

& ricn Text

Tabs

e Trending Toplcs

Visualforce

O Desitop SwikToView v || @ Refresh

Page » Visualforce

Labe ]
!
- - [ . *Vlsualforce Page Name ]
T
f— : AccountGINonoverrirde -
Toaut
|
| Helght (In plxels)
gy [
825
- -
—

21. Click the Save button.

22. Then click on Activation button and select Assign as Org Default button. This will activate your newly
created tab throughout your organization environment.
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Adding Custom Triggers

Add a Custom Trigger to Maintain Validation Status and
Validation Timestamp
This trigger allows EDQ to maintain the custom fields you have created in Adding EDQ Custom Fields to

Your Objects step. The custom trigger is responsible for maintaining the Validation status and Validation
timestamp of the addresses, emails and phone numbers within Salesforce.

1. Go to Setup > Objects and Fields > Object Manager > {Object name} (e.g. Account).
2. Navigate to to the Triggers section.
3. Click New to create a new trigger.

4. Copy and paste the following code:

trigger ExperianDataQuality_{Object Name}_BIBU on {Object API Name} (before insert,
before update) {

EDQ.DataQualityService.SetValidationStatus(Trigger.new, Trigger.old,
Trigger.IsInsert, 2); }

5. Replace {Object Name} with the name of the Object and {Object APl Name} with the APl Name of the
object.

* SETUP

Object Manager

Apex T”gger Hzlp for thiz Pags 0
Apex Trigger Edit Save| | Quick Save | | Cancel

Apex Trigger = Version Settings.

Is Active[v]
QL =@ & A A

1 |crigger ExperianDacaQuality_Bscouncl_BIBU on Account (before insert, before update) {
2 EDQ.DataQualityService.SetValidationStatus (Trigger.new, Trigger.old, Trigger.IsInsert, 2); }

6. Click Save to save the trigger.
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Add a Custom Trigger Which Will Enable Web-To-Object
Functionality

Note: This should only be done for Objects for which you would like to use Web-To-Object functionality.

1. This trigger is required to utilize Web-To-Object verification which validates addresses, emails and phone

numbers for records inserted or updated by external sources. Go to Setup - Objects and Fields >
Object Manager > {Object name} (e.g. Account) then navigate to the Triggers section.

| Search All Setup. 1 l ACCOunt Tl’lggers

Expand All | Collapse All
Define the Apex triggers for Accounts here.

Salesforce1 Setup

Help for this Page 0

Triggers New

Force.com Home =
No triggers defined

System Overview

2. Click New to create a new trigger.

3. Copy and paste the following code:

Triggers Help ' ?

trigger ExperianDataQuality_{Object Name}_AlAU on {Object API Name} (after insert, after update) {
EDQ.DataQualityService.ExecuteWebToObject(Trigger.New, 2, Trigger.IsUpdate); }

4. Replace {Object Name} with the name of the Object and {Object APl Name} with the APl Name of the
object.

5. Click Save to save the trigger.
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EDQ ADMINISTRATION SETTINGS

The following steps outline the process of configuring the Address, Email and Phone settings from the EDQ
Administration are. Turn to the relevant pages for step by step instructions.

Step Details

1. Address Verification settings Page 39

2. Email Verification Settings Page 51

3. Phone Verification Settings Page 57

Note: Your Experian Data Quality package comes with pre-configured settings for Address, Email and
Phone Verification for the Account, Contact, Lead and Contract standard Objects.

1. Configuration settings for EDQ service are completed in the EDQ Administration tab. In order to enable /
configure Address, Email and Phone Verification you will be required to grant the application permission
to your Salesforce account. If you have troubles with invoking the EDQ tab, refer to the Troubleshooting
section. The first time you access the administration area you will be requested to grant access to the
application.

(V) . . . N . N
‘E The Global Data Quality for Salesforce application requires permissions to access your Salesforce.com account. | Grant Permission Now

salesforce’

l-' H
sexperian.

Note: Due to a bug in Salesforce introduced in the Summer 17 release, the EDQ tab opens in a small iframe
when opened in Lighting Experience. Refer to the Troubleshooting section of this guide for a workaround of
this issue until Salesforce release a fix.

2. Click on the Grant Permission Now button. A pop up page will open describing the permission the
application is requesting.

Allow Access?

Global Data Quality for Salesforce is asking to:

® Access your basic information
* Access and manage your data

* Perform requests on your behalf at any time

Do you want to allow access for

kostadintsvetkov@gmail.com? (Mot you?)

e “

To revoke access at any time, go to your personal settings.
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3. Click Allow.

Note: You will only need to grant permission to the application once.

4. Once access has been granted, you will be prompted to enter your Application Key or you can sign up
for a free trial.

!'e'xperianw
" Try for FREE

Please enter your Application Key OR Start your 14-day free trial

Please complete all fields

5 B

An application key is required to complete the installation of our
app. If you have not received your application key, contact us today
on:

LOCATION PHONE HOURS (MON-FRI)

Australia +61 (0) 28907 7211 9am - Spm AEST

United Kingdom +44 (0) 800 197 7920 9am - Spm GMT United Kingdom s
USA and Canada +1(888) 771 8822 9am - Spm EST

| agree to the Terms and Conditions.

Start free trial

5. Enter your Application Key and click Submit

The Application Key is provided by your Experian representative.

Note: If you have not received your Application Key from Experian Data Quality please contact Experian
Technical Support.
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Signing up for a FREE Trial

If you would like to try the app for FREE simply complete the free trial sign up form to start your free trial.

e United States or Canada users: once you fill in the free trial form you will automatically be
provisioned with an application key and will immediately be able to proceed to the Experian Quick
Start Wizard.

e Non-United States or Canada users: once you fill in the free trial form, you will receive a
confirmation email and a member of the team will be in touch within two working days to get you up
and running with your free trial.

After your application key is registered the Experian Quick Start Wizard will open.

Note: If you wish to configure the solution within any other standard object(s), custom object(s), custom
Touchpoint(s) or custom Visualforce page(s), close the wizard and configure the solution following the steps
outlined in the “Configuration” section in the “Installation and Configuration Guide".

Start the wizard by clicking on the Let’s Get Started button.

o, .
sexperian.
Welcome to the Experian Quick Start Wizard!

About the Experian Quick Start Wizard

This wizard walks you through the basic setup of the Global Data # Address Verification
Quality for Salesforce solution within the Accounts, Contacts. Contracts
or Leads standard objects. = Email Verification

If you wish to configure the solution within any other standard objects,

custom objects or custom Visualforce page, close the wizard and . Phone Verification
configure the solution following the steps outlined in the accompanying
documentation I Contact Data Quality

Let's Get Started
or

Close the Wizard

This document provides an overview of the steps required for manually installing and configuring the
solution. Customers who wish to utilise EDQ service within the Accounts, Contacts, Contracts or Leads
standard objects can use The Experian Quick Start Wizard and accompanying Quick Start Guide to
quickly configure the solution.

1. Click the Close the Wizard button to proceed with manually installing and configuring the solution.

After you close the wizard you will be redirected to the EDQ Administration area. From here you can configure
Address, Email and Phone Settings and also manage Batch mode functionality.
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.. . .
e pmmstator EDQ Administration s experian.
| Address Verification
*| Email Verification
»| Phone Verification Address Verification
My Account
* Address Settings (Disabled)
* User Profile Seftings
EDQ Batch * Dataset Seftings
Administration * Advanced Settings
Manage Batch Jobs
Batch Job Results
Advanced Settings Email Verification

+ Email Seftings (Disabled)
* User Profile Seftings
* Advanced Settings

Logout

Phone Verification

* Phone Settings (Disabled)
* User Profile Settings.

+ Dataset Settings

+» Advanced Settings
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Enable Address Verification

Configure Address Verification Settings

Address settings are configured within the Address Verification area of the EDQ Administration tab. The
following steps outline the process for configuring Address verification.

Step Details
1. Enable Address Verification for an Object Page 39
2. Touchpoint Creation Page 42

Enable Address Verification for an Object

3.

Click the Address Settings (‘"Enabled / Disabled’).
The Address Settings page will open. It contains two sections: Enable Address Verification and Object
Settings.
Check the Enable Address Verification checkbox. This is a master switch which turns on / off Address
verification for all Objects in your Salesforce account.
EDQ Administration EDG Administration I.. 1
Address Settings ..experlon‘.

B Address Verification

Address Settings (Enabled

. Enable Address Verification Save
User Profile Settings |
Dataset Settings

Advanced Settings Enable Address Verification

*| Email Verification

Logout

¥ Phone Verification Object Settings Sex)
My Account
Action Obiject Touchpoint
Edit | Delete Account Biling Address
EDQ Batch Shipping Address
Administration Edit | Delste Contact Mailing Address
Manage Batch Jobs Other Address
Batchilon ezt Edit | Deletz  Contract Biling Address
Advanced Settings
Edit | Delete Lead Address
Click Save.

Configure Object Settings

1.

In the Object Settings section click on the Edit action link next to the Object you would like to configure
or click the New button to create and configure a new Object that is not present in the Object settings
table by default.

You will be redirected to the Object Settings page.
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o j ings o i
EDQ Administration ::;;T":i f.expel' an.

&) Address Verification

Address Settings (Enabled)

User Profile Settings. OUIRCEODIEE S| |Sme & Close | Conesh) | Detete
Dataset Seftings
Advanced Seftings ObjectMame  Account Validation Wode | Global Intuitive v
o Validate on Entry Default Dataset | United Kingdom (GBR) |
O R e Enable Web-to-Object Functionality
+| Phone Verification
My Account
Touchpoints New
EDQ Batch
Action Touchpoint

Administration Edit | Delete Biling Address
Manage Batch Jobs
Batch Job Results

Advanced Settings

Edit | Delete Shipping Address
Logout

3. Configure the settings as required:

Object Name — Choose the Object you would like to configure (e.g. Account) from the drop-down list
(required if you are configuring settings for a new Object).

Validate on Entry — Enables / Disables front-end Address verification for the selected Object. Address
validation is controlled on per Touchpoint basis therefore you should enable Address validation for each
Touchpoint where Address validation is required. Recommended mode: Enabled.

Enable Web-to-Object Functionality — This option allows you to Enable / Disable Address verification for
records created by Salesforce’s Web-to-Lead functionality or other records created from other external
sources. Validation is performed automatically when the record is created and does not require user
interaction. We advise you to make sure all mandatory fields in the Object are populated as a part of your
Web-to-Lead or external entry process to ensure the best results. Recommended mode: Enable for the Leads
object and Disable for the other objects.

Validation Mode — This dropdown contains a picklist of available validation modes which can be used to
validate an address based on your preferred workflow, we advise using the default settings for validation
mode as these are aligned with general industry preferences:

Rapid Search: The Rapid Search Address Verification workflow is used for both new and edited
records. Rapid Search mode allows you to validate an address at the point of entry quickly and
accurately, reducing keystrokes and time.

Interactive: The Interactive Address Verification workflow is used for both new and edited records.
EDQ service is invoked on Save, when a new record is created or edited, the user is directed to the
EDQ Interactive Verification screen to verify an address.

Passive: Enables silent validation, EDQ service is invoked on Save however the user will not be
prompted for verification or interaction as the process is silent. If an address is verified by EDQ or it
matched to the building level, but the required sub-building information could not be validated the
address is considered “Verified”, in all other cases the address will be returned as “"Could not be
Verified”.

Global Intuitive: The Global Intuitive Address Validation allows you to capture validated address in
real time through a predictive engine.
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Rapid Search + Interactive: Uses the Rapid Search Address Verification workflow for new record
creation and the Interactive Address Verification workflow for edited records.

Global Intuitive + Interactive: Uses the Global Intuitive Address validation for new address creation
and the Interactive Address Validation workflow for edited records.

Global Intuitive + Rapid Search: Uses the Global Intuitive Address validation for new address
creation and the Rapid Search Address Validation workflow for edited records.

. -
EDQ Administration Object Settings 'experlon
. N
- Account N
B Address Verification
Address Settings (Enabled)
Object Options Save | | Save &Close | | Cancel | | Delete
User Profile Settings g —_— e
Dataset Settings
Advanced Settings ObjectName  Account Validation Mode | Rapid Search + Interactive |
Validate on Entry | Disabled v Default Dataset | United Kingdom (GBR) v |
*| Email Verification - ) y
5 Phone Verification Enable eb-to-Object Functionality __D\sahled v Default Search Engine | Single Line %
My Account Edit Final Address on Last Screen Disabled w
Interactive Auto Accept | Disabled w
EDQ Batch Rapid Search Auto Accept | Disabled v
Rapid Search Invoke with a Button Enabled +
Administration i _
Manage Batch Jobs Mumber of Rapid Search Invokes 2
Batch Job Results Rapid Search Manual Address Entry Disabled w
Advanced Settings
i N
Logout Touchpoints lew
Action Touchpoint

Edit | Delete Biling Address.

Edit | Delete Shipping Address

Note: For more information regarding the validation modes please refer to the user guide.

After selecting an option from the validation mode dropdown several options relevant to the selected - will be
displayed on the page:

Default Dataset (displays for Rapid Search and Global Intuitive) — The setting allows you to choose a
default Dataset for the Rapid Search and Global Intuitive Address Verification popup.

Default Search Engine (displays for Rapid Search) — The setting allows you to choose a default search engine
for the Rapid Search Address Verification popup. The options are: “Singleline”, “Typedown”, “Verification” and
“Intuitive”. The solution provides a number of distinct search engines that can be used to facilitate the address
capture process. For more information on the specific search engines please refer to the user guide

Single Line - The Single Line engine is designed so that the user can enter minimal information in
order to produce a list of matching and close-matching addresses from which they can select the
required one.

Typedown - The Typedown engine is designed to allow the user to drill down through a series of
picklists to select the required address. When a user enters text into the search field, the picklist is
updated a short period after the user stops typing. The more characters that the user enters, the more
refinement is shown in the picklist. This 'dynamic refinement' enables searches to be initiated within
the EDQ pop up without the user having to hit ‘Enter' or click the ‘Search’ button as is the case with
Single Line.

Intuitive - The Intuitive Search engine is designed so that the user can enter addresses quickly and
easily, using a real-time picklist. The Intuitive Search scenario does not require further refinement after
the address has been entered, as it starts with the most specific address elements. As the user types,
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the picklist automatically updates with suggestions. The Intuitive Search mode only supports picklists
returned in a flattened mode and is available for the following datasets only (AUS, AUG, NZL, NZG,
and FRI).

Verification - The Verification engine is designed so that only minimal interaction, or none at all, is
required from the user. The user enters their whole address in the same way that it would be written
on an envelope, and the entire address is submitted to the engine. The engine returns a verification
level which corresponds to the degree of confidence in the returned (and reformatted) match. For
addresses that could not be matched with confidence, further interaction may be required.

Edit Final Address on Last Screen (displays for Rapid Search and Interactive, plus combinations
including Rapid Search or Interactive) — Set this option to Enabled if you would like users to be able to
edit the verified address on the final screen of the address verification user interface. Editing the final
address will return a Validation Status of "User Preferred".

Interactive Auto Accept (displays for Interactive) — This setting determines whether addresses validated
by EDQ are auto accepted without any intervention from the user. If you choose to enable this option
addresses which are returned as “Verified" or as “Could not be verified" will automatically be accepted and
pasted back to the Salesforce page. Recommended mode: Disable.

Rapid Search Auto Accept (displays for Rapid Search) — This setting determines whether verified
addresses are automatically accepted without any intervention from the user. If this setting is set to
Enabled, verified addresses will be automatically pasted back to the Salesforce page. Recommended
mode: Disable.

Rapid Search Invoke with a Button (displays for Rapid Search) — Rapid Search can be invoked in one of
two ways, this setting determines how Rapid Search is invoked. If you set this option to Enabled, the
Rapid Search popup will be invoked with a button, in this scenario a Validate button is positioned
alongside the address fields, when clicked Rapid Search will be invoked. If you set this option to Disabled,
there is no Validate button, instead Rapid Search will be invoked as soon as the user clicks into or tabs
into one of the address fields.

Number of Rapid Search Invokes (displays for Rapid Search) — Determines the number of times the
Rapid Search pop up can be invoked when Invoke Search Engine with a Button is set to ‘Disabled’. For
example, setting this to 3 allows users to invoke, close and re-invoke the Rapid Search pop up a
maximum three times within a single record creation or edit workflow, on the fourth attempt the pop up
will not invoke. This option is only relevant if you have set Invoke Search Engine with a Button to
Disabled.

Rapid Search Manual Address Entry (displays for Rapid Search) — This setting enables users to
manually enter an address within the Rapid Search pop up. If you set this option to Enabled a Enter
Address Manually link is available on the bottom right of the Rapid Search pop up, when clicked users are
able to manually enter an address. Manually entering an address will return a Validation Status of
“Manually Entered”.

4. Click Save to maintain your settings.
Touchpoint Creation

The next step after you have configured your Object settings is to create the Touchpoints. Touchpoints allow
users to setup a point of reference between Salesforce and the EDQ service. Users define input mappings (the
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address fields which contain the data to be validated) and output mappings (where the solution returns
verified address data)

1. Select the Edit action link if you want to configure existing Touchpoint settings or click the New button to
create a new Touchpoint. The Touchpoint Settings page opens.

Note: Note that the mandatory fields are marked with a red line.

Touchpoint Settings

Object Name  Account

Touchpoint Name I| Biling Address

Validate on Entry Disabled w

Touchpoint name: Type a unique name for your Touchpoint (e.g. Billing Address)
Validate on Entry: Select Enabled from the dropdown

Input Mapping

Input Mapping allows data already entered into Salesforce to be verified or used as the starting point for an
Address Search. Mapping the fields of your Salesforce form to EDQ Address Fields enables the solution to find
the best match against your existing address data.

Use the Address Field picklist on the left side to select an EDQ address field and map it to the corresponding
Object field from the picklist on the right side. You may use the Add Another Mapping link to create a new
mapping if needed.

Input Mapping

Address Field Object Field

| street v|  [Biling Street v @
| city | [giling ity v @
| state ~|  [Biling State/Province v @
| Postcode ~|  [Biling Zip/Postal Cade v @
| country | [Biling Country v @

Add Another Mapping

Note: Country and Street or City are mandatory fields for Input Mapping.

System Fields Output Mapping

In this section, you will be prompted to map the Validation Status and the Validation Timestamp fields. The
Validation Status filed is a Text field which stores the current validation status. The Validation Timestamp field
is a Date / Time field which stores the timestamp of the last validation attempt by Experian Data Quality.

System Fields Output Mapping

Validation Status || Biling Address Validation Status W |

Validation Timestamp I| Biling Address Validation Timestamp Y] |

Note: Validation Status field is mandatory for Interactive search and for Web-to-Lead.

43



Output Mapping
Output Mappings control the way the solution returns the final address results into your Salesforce fields.

Select the Edit action link if you want to configure the output mapping for an existing Dataset or click the

New button to create new dataset output mapping. You will be redirected to the Per Dataset Output
Mapping page.

From the Dataset dropdown, you can leave Default or choose a preferred Dataset.

Default Dataset — The Default layout and associated Output mappings will be used for all datasets, if an

individual dataset output mapping (Preferred dataset) is created, this will overwrite the default output

mapping for that specific country

Note: If you would like to utilize the Global Intuitive search engine, you need to create an output mapping

for the Default Global Intuitive dataset.

1. Default Dataset - If you choose the Default dataset the Layout field is automatically populated with the
default layout settings.

2. The structure of the Layout is listed on the right.

3. Use the Address Field picklist to select the Layout line and the corresponding Object Field picklist to
select the Salesforce field the Layout line should be mapped too.

4. Add Another Mapping — You may use this link to create a new mapping if needed.

Touchpoint Settings .. . .

Account ..experlon..

Per Dataset Output Mapping Save | | Save &Close | | Cancel | | Delete

Dataset | Default v

Layout SalesforceDefault w

Object Field Address Field

| Bilng street v| [Lsteett v1® [ syeets
| Biling street v| [2street2 v| @ | 2street2
| siling city v] [zoy V@ | 3cw

4. State/Province
5. ZIP/Postal Code
I| Biling Zip/Postal Code W | | 5, ZIP/Postal Code W | ° 6. Country/Region

I| Biling State/Province W | |4. State/Province W | °

I| Billing Country W | |6. Country/Region W | °

Add Another Mapping

Save your changes by clicking the Save & Close button.

Preferred Dataset

If you would like to create a specific output mapping for a particular Dataset you can override the Default

output mapping.

1. Choose your preferred Dataset from the dropdown (e.g. United Kingdom).

2. Select your Layout from the dropdown (e.g. Salesforce Typedown).

3. The structure of the Layout is listed on the right.

4. Use the Address Field picklist to select the Layout line and the corresponding Object Field picklist to select

the Salesforce field the Layout line should be mapped too.
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5. Add Another Mapping — You may use this link to create a new mapping if needed.

Note: You will have to create a mapping for at least one field.

EDQ Administration
B Address Verification
Address Seftings (Enabled)

User Profile Settings
Dataset Settings
Advanced Settings

| Email Verification
*| Phone Verification

My Account

EDQ Batch

Administration
Manage Batch Jobs
Batch Job Results
Advanced Settings

Logout

) ! .,
Touchpoint Settings ™ .
Account '.experlon‘-

Per Dataset Output Mapping Save | | Save &Close | | Cancel
Dataset |Un|bed Kingdom (GER) vl
Layout | SalesforceTypedown w |
Object Field  Address Field

I‘ Biling Street “’l |4‘°”E* "l -] 1. Three character IS0 country code L)

I‘ Billing City vl |4Nnne— vl Q2

I‘ Biling State /Province vl |—None— "l a 3.
4.

| Biling zip/Postal Code | [ione~ v Q@ 5. Organisation

| Eiling Country v|  [-tione—- w| & & Department

Add Anather Mapping

7. Sub-building name

8. Sub-building number

9. Building name

10. Building number

11. Dependent thoroughfare (Name)

12. Dependent thoroughfare (Descriptor)
13. Thoroughfare (Name)

14. Thoroughfare (Descriptor)

15. Double dependent locality

16N Incalite

6. Save your changes by clicking the Save & Close button and then Save on the Touchpoint Settings page.

Note: Follow the same steps to enable Address Validation for any other custom or standard Object
(Contact, Contract, Lead etc.)

Additional Options

In the left-side menu of the EDQ Administration pane, under Address Verification you can also see the User

Profile Settings, the Dataset Settings and the Advanced Settings links.

User Profile Settings

This section allows you to specify which user profiles have access to address verification functionality and

allows you to configure certain settings on a per user profile basis.

To specify which user profiles, have access to address verification functionality follow the steps below:

1. Select the User Profile Settings link. The User Profiles page opens displaying a list of enabled User

Profiles.
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EDQ Administration

B Address Verification
Address Settings (Enabled)
User Profile Settings.

Dataset Seftings
Advanced Seftings

*| Email Verification
*| Phone Verification

My Account

EDQ Batch

Administration
Manage Batch Jobs
Batch Job Results
Advanced Settings

Logout

2. Click the Configure button to open the Configure User Profiles page.

EDQ Administration
User Profiles

-- L] .
g .experlcnw

User Profiles Configure
Action Profile

Edit | Delete Analytics Cloud Integration User

Edit | Delete Analytics Cloud Security User

Edit | Delete Authenticated Website

Edit | Delete Authenticated Website

Edit | Delete Chatter External User

Edit | Delete Chatter Free User

Edit | Delete Chatter Moderator User

Edt | Delete Chatter Only User

Edt | Delete Company Communities User

Edt | Delete Contract Manager

1-100f43 [v] 4 {Previous Nexth

A/B/C|D|E|F G H|I|JKIL M N|O|P|QR S TUV WX Y|Z Other ANl

Page of &

3. From the list on the left select the User Profiles you would like to enable Address Verification for (e.g.
System Administrator).

4. Click on the Add button to enable Address Verification for the selected User Profiles.

EDQ Administration

B Address Verification
Address Settings (Enabled)
User Profile Settings
Dataset Settings

Advanced Settings

*| Email Verification
*| Phone Verification

My Account

EDQ Batch

Administration
Manage Batch Jobs
Batch Job Results
Advanced Settings

Logout

5. Click Save.

To configure Address Verification settings on a per User Profile basis follow the steps below:

EDG Administration

User Profile Settings

..l .
._expenonw

Save | | Cancel

Configure User Profiles

Avialable User Profiles Enabled User Profiles

Read Only Analytics Cloud Integration User ~
Analytics Cloud Security User
Sitver Partner User Authenticated Website
Add Authenticated Website
[LJ Chatter External User
w Chatter Free User

Remove |Chatter Moderator User
Chatter Only User
Company Communities User
Contract Manager

Cross Org Data Proxy User
Fuetom: inn Dol

1. Click on the User Profile Settings link. The User Profiles page will open displaying the enabled User
Profiles in a table.

2. Click on the Edit action link next to the required User Profile from the table.

3. The Profile page will open. From this page you can select specific settings on per User Profile basis for all
Objects for which address verification Touchpoints were created.

You will notice that initially all settings are set to Default. If you leave the Default value for a setting, the

actual setting value will be taken from the value chosen in the Object Settings. The current default value is

shown in parentheses next to “Default".
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Address Settings
Analytics Cloud Integration User Profile

EDQ Administration

& Address Verification

.- - .
. .experlcm..

Address Settings (Enabled)

Save

User Profile Settings Save & Close | | Cancel

Dataset Settings
Advanced Settings

Account Settings

Validation Mode | Defauit [Global Intitive] v
+| Email Verification

*+/ Phone Verification

Default Dataset Default [United States (USA)]

Edit Final Address on Last Screen Default [Disabled] w

My Account

Dataset Settings

Click on the Dataset Settings link. The Dataset Settings page opens displaying a list of all available Datasets

for which you are licensed.

. ., .
EDQ Administration EDQ Administration . .expenon
Dataset Settings ER .
B Address Verification
Address Seftings (Enabled)
i Ricri| B [ielete Setected A|B[C|D[E[F[G|H|I|J|K|L|IM|N|O|P|Q|R|S|T|U|V WX
User Profile Settings Dataset Settings
Refresh Dataet Settings Y Z|Other All
Dataset Settings e —
Advanced Seftings [[] setien Dataset Hame Inital Engine Flatten Picklists Alias(es)
[] Edit | Delete Afghanistan (AFG) Defautt Enabled AF
¥ Emiail Verificati
mal erification [] Edit Delte  Albania (ALB) Defaut  Enabled AL
*| Phone Verification X
My Account [1 Edit | Delete Algeria (DZA) Default Enabled Dz
[] Edit | Delete Andorra (AND} Defautt Enabled AD
[0 Edit | Delste Angela (AG0) Defautt Enabled AQ
EDQ Batch
[] Edit | Delete Antigua and Barbuda (ATG) Defautt Enabled AG
Administration [ Edit| Delste  Argentina (ARG} Defaut Enabled AR, ARGENTINA
Manage Batch Jobs .
[1 Edit | Delete Armenia (ARM) Default Enabled AN
Batch Job Results
Advanced Settings [] Edit | Delete Aruba (ABW) Default Enabled AW
D Edit | Delete Australia (AUS) Defautt Enabled AU, AUSTRALWA, OZ
1-100f193 |v (0 selected 44 {Previous Nexth W Page 1 |of20

Logout

To create a new set of Datasets Settings, click the New button, to edit an existing set of Dataset Settings

select the Edit action link next to the specific Dataset. You will be redirected to the Dataset Settings page.

. a,
EDQ Administration Dataset Settings . s .
Edit Dataset Settings «£xperian.
B Address Verification
Address Settings (Enabled)
User Profile Settings Dataset Settings Save Save & Close | | Cancel Delete

Dataset Seftings

Advanced Setings Datasettame | United Kingdom (GBR)

Default v

Initial Engine
*| Email Verification

| Phone Verification

Dataset Aliases INIGRETCHLE ROYAUME, WALES

All Ei
My Account o EmeRy D
Flatten Picklists || Enabled w
Restore Defaults
EDQ Batch

Dataset name — if you are editing an existing set of Dataset settings, this dropdown box will display the name

of the Dataset.

If you are creating a new set of Dataset settings, this dropdown box will be populated with a list of all datasets

available which do not already have a set of Dataset Settings configured.

Initial Engine — choose from the dropdown list or leave Default. If you leave the Default value the actual

setting value will be taken from the value chosen in the Object Settings.

Data Set Aliases — The available aliases for the selected Dataset are displayed in this field. You can also enter

additional aliases if needed.
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Allow Empty — Checking this checkbox allows you to assign an empty value as an alias for the selected
Dataset.

Flatten Picklists — this mode is designed to produce simple picklists from which users can easily select the
correct address. This mode returns picklists that cannot be refined or stepped into (except in special
circumstances) and are useful when little user interaction is needed.

Note: This setting applies to the Singleline search engine only. Any picklists returned by the Verification
engine will always be returned as flattened picklists.

Restore Defaults — Select this link to restore all your default dataset settings if needed.

Click Save & Close to save your settings.
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Advanced Settings

The advanced settings sections give you full control over address search behavior. We do not recommend
changing these settings without consulting with your EDQ representative.

Click on the Advanced Settings link to be directed to the Advanced Settings page. You will see the following
fields:

EDQ Administration Address Settings

.,
s .
Advanced Settings . _experlcln..

B Address Verification
Address Settings (Enabled)

User Profile Settings Save Save & Close | | Cancel
Dataset Seftings

Advanced Seftings Upon Failure Disable Interactive For IIO m Search Intensity
{min}

»| Email Verification Start Initial Intuitive Search After I‘z | Timeout [sec) |‘ 10 |

{char}

*| Phone Verification Threshold |25 |
Refine Intuitive Search After (sec) | 1 |
My Account Concatenation Separator
Maximum Picklist ltems Count in |‘ 100 |
Rapid Search Custom Separator
Restore Defaults Maximum Picklist tems Count in
EDQ Batch 7w
) Global Intuitive
T Tl Display Country Field Above the

Address for Global Intuitive
Manage Batch Jobs

Batch Job Results Choose your Validation Status Verified by Experian w

Advanced Settings

Logout
Upon Failure Disable Interactive For — allows you to set the number of minutes for which you would like to
disable Interactive address verification in case of a failure or a timeout.

Start Initial Intuitive Search After — shows how many characters the users should enter before they start the
validation process for the Intuitive engine in Rapid Search and Global Intuitive mode.

Refine Intuitive Search After — This option sets the number of seconds the intuitive search engine should
wait before refining the search once a new character is entered.

This option applies to the Intuitive search engine in Rapid Search mode.

Maximum Picklist Items Count in Rapid Search — Determines the maximum number of picklist items
(results) that will be displayed within the picklist for Rapid Search mode.

Search Intensity — The value of this drop-down box defines the intensity with which the search engine will

work to obtain a match. A higher intensity may yield more results but will also result in longer search time. The
following Search Intensity values are available:

Exact: This value allows no mistakes in the search term but is the fastest.

Close: (Recommended): This value allows some mistakes in the search term and is the default setting.

Extensive: This value allows many mistakes in the search term, but results in the longest search time.

Timeout (sec) — The timeout is a numerical value (entered in seconds) that specifies a time limit for the
search. The default setting is 10 seconds.

Threshold — The threshold is a numerical value that provides a cut-off point for the number of matches
returned by a search. The threshold can range from 5 to 100. The default setting is 25.

Concatenation Separator — The concatenation separator provides you with the ability to select a separator
when more than one output address line is mapped to an address field.
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Custom Separator — The custom separator is available only when the “Use custom separator” value is selected
in the Concatenation Separator dropdown and provides you with the ability to use a custom value as a
concatenation separator.

Maximum Picklist Items Count in Global Intuitive - Determines the maximum number of picklist items
(results) that will be displayed within the picklist when utilizing the Global Intuitive validation mode.

Choose Your Validation Status — This option provides you the ability to choose whether your verified status
to be “Verified by Experian” or “Verified by Experian QAS".

Note: If you would like to migrate your status from Verified By Experian QAS to Verified by Experian
please contact EDQ and we can provide documentation and sample script guidance with that process.

Restore Defaults — Click this link If you wish to restore the default settings on the page.
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Enable Email Verification

Configure Email Verification Settings

Email configuration settings is performed within the Email Verification area of the EDQ Administration tab.
The following steps outline the process for configuring Email verification:

Step Details
1. Enable Email Verification for an Object Page 51
2. Touchpoint Creation Page 52

Enable Email Verification for an Object
1. Click on the Enable Email Verification link in the EDQ Administration pane. The Email Settings page will
open. It contains two sections: Enable Email Verification and Object Settings.

2. Check the Enable Email Verification checkbox. This is a master switch which turns on / off Email

Verification in your Salesforce account for all Objects.

R .,
- " EDQ Administration .
EDQ Administration a
Email Settings ._experlon.,
+| Address Verification
B Email Verification
Emal Seftings (Enabled) Enable Email Verification S
User Profile Seftings
Advanced Settings Enable Email Verification
+| Phone Verification
My Account Object Settings pher
Action Object Touchpoint
EDQ Batch Edit | Delete Contact Email
Administration Edit | Delete Lead Email

Manage Batch Jobs

3. Click Save.

Configure Object Settings

1. In the Object Settings section click the Edit action link next to the Object you would like to configure or
click the New button to create and configure a new Object that is not present in the Object settings table.

2. You will be directed to the Object Options page.

. .,
EDQ Administration Object Settings . ) [ ] i
Create New Object Settings ..experlc:n.,

*| Address Verification
B Email Verification

Email Settings (Enabled) Object Options Sai (SmeSClose [l Cance

User Profile Settings

Advanced Settings Object Name I -Hone—- v Validation Mode I —Mone—- v

Validate on Entry Enabled w
*| Phone Verification

My Account Enable Web-to-Object Functionality Enabled w

Object Name - Choose the Object you would like to configure (e.g. Account) from the drop-down list
(required if you are configuring settings for a new Object).
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Validate on Entry — Enables / Disables front-end Email verification for the selected Object. Email validation is
controlled on a per Touchpoint basis therefore you should enable Email validation for each Touchpoint where
Email validation is required. Recommended mode: Enabled.

Enable Web-to-Object Functionality — This option allows you to Enable / Disable Email verification for
records created by Salesforce.com’s Web-to-Lead functionality or other external sources. Validation is
performed automatically when the object is created and does not require user interaction. Recommended
mode: Enable for the Leads object and Disable for the other objects.

Validation Mode — This dropdown shows a picklist of the following options for setting your preferred
workflow:

Inline: Email verification is performed “inline” directly on the Salesforce page.

Interactive: Email verification is invoked on Save and is performed via the Interactive Validation
workflow.

Passive: Email verification is invoked on Save, however it will be performed silently and there is no
interaction with the user.

Auto Accept - (displays when Interactive Validation mode is selected) — Allows users to Enable / Disable
automatic accepting of email addresses for which EDQ was able to conclusively classify as “Verified" or "Not
Verified". If you enable this option the EDQ interactive email verification behaves in the following way:

If the email you enter comes back with one of the selected Verified Certainties in the Email Verification >
Advanced Settings section in the EDQ Administration area, EDQ will automatically accept the email and mark
it as "Verified by Experian" without further user interaction. By default, email addresses which come back with a
validation certainty levels of “Verified" or “Unknown" are treated as verified.

If the email you enter comes back with one of the not selected Verified certainties in the Email Verification >
Advanced Settings section in the EDQ Administration area, EDQ will automatically accept the email and mark
it as "Could not be Verified" without further user interaction. By default, email addresses which come back with

a validation certainty levels of “Undeliverable”, “"Unreachable”, "Illegitimate” or "Disposable" are treated as not
verified.

If the email you entered cannot be conclusively verified by EDQ and it comes back with suggestions you will
be presented with the multiple match EDQ Verification screen (for more information refer to the User Guide)
where you may choose to accept one of the suggested corrections or choose the original email you entered.

For more information on Verified Certainties navigate to the Advanced Settings section on page 53.
Recommended mode: Disabled.

3. Click Save.
Touchpoint Creation

The next step after you have configured your Object settings is to create Touchpoints.

Select the Edit action link if you want to configure Touchpoint settings for an existing Touchpoint or click the
New button to create a new Touchpoint. The Touchpoint Settings page opens.
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B Email Verification
Save = Save & Close | Cancel
Email Settings (Enabled)

User Profile Settings Touchpoint Settings
Advanced Settings Object Name  Account
»| Phone Verification Touchpoint Name ||
My Account Validate on Entry Enabled ¥

Touchpoint name: Type a unique name for your Touchpoint.
Validate on Entry: Select Enabled from the dropdown.

Input Mapping

Input mapping is used to identify (map) the email components of your Salesforce form which are to be
utilized for Email Verification.

Use the Email Field picklist on the left to select an EDQ email field and the Object Field picklist on the right to
select a field which will contain the relevant email data.

Input Mapping
EDQ Batch Email Field Object Field
Administration | Email vl

Manage Batch Jobs

System Fields Output Mapping

In this section, you will be prompted to map the Validation Status, the Validation Timestamp and the
Validation Message fields. The Validation Status filed is a text field which stores the current validation status.
The Validation Timestamp field is a Date / Time field which stores the timestamp of the last validation
attempt by EDQ. The Validation Message field is used to store the returned validation message.

Batch Job Results System Fields Output Mapping
Validation Status | Choose Field v
Validation Timestamp I} Choose Field 7;i
Validation Message iCﬁooiséFlieldii' |

Note: When utilizing the Verification workflow the Validation Status field is mandatory.

Output Mapping
The output mapping allows you to map Email address results to Salesforce fields.

Use the picklist on the left to select the available Object output fields in your Salesforce form and select the
appropriate EDQ Email field item which should be returned to the required Salesforce field.

Add Another Mapping - select this link if you want to map more fields on your form. You can use the (&)
icon to remove desired fields.

There is a range of additional email data which can be stored within your Salesforce fields to further enhance
and improve decision making and email effectiveness. Please refer to the User Guide for detailed explanations
on the additional data available.
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Output Mapping

Object Field Email Field

|\ Account Email v \ | 1. Emnail v 1. Email

Add Another Mapping 2. Certainty
3. Message
4 Corrections

Click Save & Close.

Note: You have to follow the same steps to enable Email Validation for any other custom or standard
Object (Contact, Contract, Lead etc.)

Additional Options

In the left-side menu of the EDQ Administration you can see the User Profile Settings and the Advanced
Settings.

User Profile Settings

This section allows you to specify which user profiles have access to email verification functionality and allows
you to configure certain settings on a per user profile basis. To specify which user profiles, have access to
email verification functionality follow the steps below:

1. Select the User Profile Settings link. The User Profiles page will open displaying a list of enabled User

Profiles.

EDQ Administration EDQ Administration -gx enon
User Profiles s p "

*| Address Verification
B Email Verification

Email Seftings (Enabled) User Profiles Configure A|B|C|D E|F GH|I|J|KIL/M(N|O|P(QR|S(T(U|V(W|X| Y|Z| Other JAN

User Profile Settings

Action Profile

Advanced Settin
o Edit (Delete  Analytics Cloud Integration User

*| Phone Verification Edit | Delete Analytics Cloud Security User
My Account Edit | Delete Authenticated Website

Edit | Delete Authenticated Website

EDQ Batch Edit | Delete Chatter External User
Chatter Free User
Administration Edit | Delete
Manage Batch Jobs Edit | Delete Chatter Mederator User
Batch Job Results Edit | Delete Chatter Only User
Advanced Settings Edit | Delete Company Communities User

Edt | Delete Contract Manager
Logout 1-100743 [v] 4 4Provious Nexth W Page| 1 |ofs

2. Click on the Configure button and you will be led to the Configure User Profiles page.

3. From the list on the left select the user profiles you would like to enable Email verification for (e.g. System
Administrator).

4. Click on the Add button to enable Email verification for the selected User Profiles.
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EDQ Administration

*| Address Verification
B Email Verification
Email Settings (Enabled)

User Profile Settings

Advanced Settings

| Phone Verification

My Account

EDQ Batch

Administration
Manage Batch Jobs
Batch Job Results
Advanced Settings

Logout

5. Click Save.

EDQ Administration

User Profile Settings

'- L] -
. _experlan.,

Save Cancel

Configure User Profiles

Avialable User Profiles Enabled User Profiles
Custom: Marketng Profie
Analytics Cloud Security User Custom: Sales Profile
Authenticated Website Custom: Support Profile
Authenticated Website Add Customer Community Login User
Chatter External User u Customer Community Plus Login User
Chatter Free User w Customer Community Plus User
Chatter Moderator User Remove | Customer Community User
Chatter Only User Customer Portal Manager
Company Communities User Customer Portal Manager Custom
Contract Manager Customer Portal Manager Standard
Cross Org Data Proxy User Force.com - Free User

Eold Dartnar 1L

Configure Email Verification Settings

To configure Email Verification settings on a per User Profile basis follow the steps below:

1. Click on the User Profile Settings link. The User Profiles page will open displaying the enabled User
Profiles in a table.

2. Click on the Edit action link next to your User Profile from the table.

3. The Profile page will open. From that page, you can select specific settings on per User Profile basis for all

Objects for which email verification Touchpoints have been created.

EDQ Administration

*| Address Verification

B Email Verification
Email Settings (Enabled)
User Profile Settings

Advanced Seftings

*| Phone Verification

My Account

EDQ Batch

Administration
Manage Batch Jobs
Batch Job Results
Advanced Settings

Logout

Address Seftings

Analytics Cloud Integration User Profile

.-. -
._experlan..

Save Save & Close | | Cancel
Account Settings
Validation Mode I Default [Inling] w
Contact Settings

Validation Mode I Default [Interactive]

Auto Accept Default [Enabled] +
Lead Settings

Validation Mode | Default [Iniine] v

Advanced Settings

The advanced settings section gives you full control over Email verification behavior. We do not recommend

changing these settings without consulting with your EDQ representative.

Expand Email Verification and click on the Advanced Settings link to be directed to the Advanced Settings
page. You will see the following fields:
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EDQ Administration Email Settings

.,
s .
Advanced Settings . .experlcn..

*| Address Verification
B Email Verification

Email Settings (Enabled) Save Save & Close |  Cancel
User Profile Seftings - -
Advanced Settings Timeout {sec) I
Veridston essage Tmeout(se) |5 |
*| Phone Verification
My Account Choose Your Validation Status
Verified Certainties
EDQ Batch vennes
Undeliverable D
Administration Unreachable [ ]
Manage Batch Jobs lllegitimate [ ]
Batch Job Results Disposable ]
Advanced Settings Unknown

estore Defaults

el

Logout

Timeout (sec) — The email validation search timeout in seconds. The default is 15 seconds

Validation Message Timeout (sec) — If the email address entered by the user is invalid, a validation message
is displayed providing insight into the validation status, this setting determines how long the validation
message should remain visible on the page. The default setting is 6 seconds.

Choose Your Validation Status — This option provides you the ability to choose whether your verified status
to be "Verified by Experian” or "Verified by Experian QAS".

Verified Certainties — Certainty indicates the Email status. This option allows you to set certainties should be
considered verified and return an Email Validation Status of “Verified by Experian”. Below are the Certainty
definitions. Verified and Unknown are the recommended and default values which should be checked.

Verified: Mailbox exists, is reachable and not known to be illegitimate or disposable.

Undeliverable: The mailbox or domain is not deliverable — it doesn't exist, it is suspended, or the
mailbox is full.

Unreachable: Domain has no reachable mail exchangers. ‘Invalid domain’; either no DNS records,
invalid ones, or there isn't a mail server listing.

Illegitimate: Seed, spam trap, black hole, technical role account, inactive domain or other potentially
harmful address.

Disposable: \We were unable to conclusively verify or invalidate this email address. The address
doesn’t appear to be nefarious (as far as we know), but we can’t determine if it is deliverable or not.

Unknown: We were unable to conclusively verify or invalidate this email address. The address doesn't
appear to be nefarious (as far as we know), but we can’t determine if it is deliverable or not.

Restore Defaults — select this link if you wish to restore the default settings.

Leave this page populated with Default and click Save & Close button.
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Enable Phone Verification

Configure Phone Verification Settings

Phone settings configuration is performed within the Phone Verification area of the EDQ Administration tab.
The following steps outline the process for configuring Phone verification:

Step Details
1. Enable Phone Verification for an Object Page 57
2. Touchpoint Creation Page 58

Enable Phone Verification for an Object
Click on the Enable Phone Verification link in the EDQ Administration pane. The Phone Settings page will
open. It contains two sections: Enable Phone Verification and Object Settings.

1. Check the Enable Phone Verification checkbox. This is a master switch which turns on / off Phone
Verification in your Salesforce account for all Objects.

EDQ Administration

Phone Settings

[ ]
EDQ Administration !e.)(pel'lon
» Address Verification .

*| Email Verification

B Pnone Verification Enable Phone Verification e

Phone Settings (Enabled)
User Profile Settings Enable Phone Verification

Dataset Seftings

Advanced Settings

‘Object Settings New
My Account
Action Object Touchpoint
Edit | Delete Account Phong
EDQ Batch

Edit | Delete Contact Assistant Phone

Administration
Manage Batch Jobs
Batch Job Results
Advanced Settings

Home Phone
llobile Phone
Other Phone
Phone

Edit | Delete Lead Mobile Phone

Phong
Logout

2. Click Save.

Configure Object Settings

1. In the Object Settings section click the Edit action link next to the Object you would like to configure or
click the New button to create and configure a new Object that is not present in the Object settings table.

2. You will be directed to the Object Options page.

Object Settings

Create New Object Settings

L)
EDQ Administration !e‘xperlon
*| Address Verification .

*| Email Verification

B Phone Verification Object Options $ave | [ Save & Close | | Cancel

Phone Settings (Enabled
Object Name I ~one— hd

User Profile Settings validation Mode || None— v

Dataset Seftings
Advanced Settings

My Account

Validate on Entry Enabled

Enable Web-to-Object Functionality Enabled w

Default Country Code

+1

W
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Object Name — Choose the Object you would like to configure (e.g. Account) from the drop-down list
(required if you are configuring settings for a new Object).

Validate on Entry — Enables / Disables front-end Phone verification for the selected Object. Phone validation
is controlled on a per Touchpoint basis therefore you should enable Phone validation for each Touchpoint
where Phone validation is required. Recommended mode: Enabled.

Enable Web-to-Object Functionality — This option allows you to Enable / Disable Phone verification for
records created by Salesforce’s Web-to-Lead functionality or other external sources. Validation is performed
automatically when the object is created and does not require user interaction. We advise you to make sure all
mandatory fields in the Object are populated as a part of your Web-to-Lead or external entry process.
Recommended mode: Enable for the Leads object and Disable for the other objects.

Validation Mode — This dropdown shows a picklist of the following options for setting your preferred
workflow:

Inline: Phone verification is performed “inline” directly on the Salesforce page.

Interactive: Phone verification is invoked on Save and is performed via the Interactive Validation
workflow.

Passive: Phone verification is invoked on Save, however it will be performed silently and there is not
interaction with the user.

Auto Accept - (displays when Interactive Validation mode is selected) — Allows users to Enable / Disable
automatic accepting of phone numbers which EDQ classifies as “Verified" or "Not Verified". If you enable this
option the EDQ interactive phone verification behaves in the following way:

If the phone number you enter comes back with one of the selected Verified Certainties in the Phone
Verification > Advanced settings section of the EDQ Administration area, EDQ will automatically accept the
number and mark it as "Verified by Experian" without further user interaction. By default, phone numbers
which come back with a validation certainty levels of “Verified”, “Absent”, “Teleservice not provisioned" or
"Unknown" are treated as verified.

If the phone number you enter comes back with one of the not selected Verified certainties in the Phone

Verification 2 Advanced settings section of the EDQ Administration, EDQ will automatically accept the

number and mark it as "Could not be Verified" without further user interaction. By default, phone numbers
which come back with a validation certainty levels of “Unverified” are treated as not verified.

For more information on Verified Certainties navigate to the Advanced Settings section on page 60.
Recommended mode: Disabled.

Default Country - If you do not map country in the Input Mappings for your phone touchpoint your phone
numbers will be verified against the dataset specified in the Default country option. Use this option if you
would like to verify phone numbers for only one country.

3. Click Save.

Touchpoint Creation

The next step after you have configured your Object settings is to create Touchpoints.

1. Select the Edit action link if you want to configure Touchpoint settings for an existing Touchpoint or click
the New button to create a new Touchpoint. The Touchpoint Settings page opens.
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User Profile Settings Save | | Save & Close | | Cancel
Dataset Setlings

Advanced Settings Touchpoint Settings
My Account Object Name  Account
Touchpoint Name || Phone
EDQ Batch Vvalidate on Entry | Enabled v

Touchpoint name: Type a unique name for your Touchpoint.
Validate on Entry: Select Enabled from the dropdown.

Input Mapping

Input mapping is used to identify (map) the phone components of your Salesforce form which are to be
utilized for Phone Verification.

Use the EDQ Phone Field picklist on the left to select a phone field and the Object Field picklist on the right to
select a field which will contain the relevant phone data.

Administration Input Mapping
Manage Batch Jobs

Batch Job Results Phone Field Object Field

| Number v | [Account Phone M

Add Another Mapping

System Fields Output Mapping

In this section, you will be prompted to map the Validation Status, the Validation Timestamp and the
Validation Message fields. The Validation Status filed is a text field which stores the current validation status.
The Validation Timestamp field is a Date / Time field which stores the timestamp of the last validation
attempt by EDQ. The Validation Message field is used to store the returned validation message.

System Fields Output Mapping

Validation Status || Choose Field v
ion T | Choose Field v
Validati | Choose Field v
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Output Mapping
The output mapping allows you to map Phone results to Salesforce fields.

Use the picklist on the left to select the available Object output fields in your Salesforce form and select the
appropriate EDQ Phone field item which should be returned to the required Salesforce field.

Add Another Mapping - select this link if you want to map more fields on your form. You can use the (&)
icon to remove desired fields.

There is a range of additional phone data which can be stored within your Salesforce fields to further enhance
and improve decision making and phone verification effectiveness. Please refer to the User Guide for detailed
explanations on the additional data available.

Qutput Mapping

Object Field Phone Field

|| Account Phone v ‘ |6 Mumber v 1. Certainty
Add Another Mapping 2. CountryName
3. CountryCode
4. IsRoaming
5. MCCMNC

Click Save & Close.

Note: Follow the same steps to enable Phone Validation for any other custom or standard Object (Contact,
Contract, Lead etc.)

Additional Options

In the left-side menu of the EDQ Administration area you can see the User Profile Settings, Dataset Settings
and the Advanced Settings.

User Profile Settings

This section allows you to specify which user profiles have access to phone verification functionality and allows
you to configure certain settings on a per user profile basis. To specify which user profiles have access to
phone verification functionality, follow the steps below:

1. Select the User Profile Settings link. The User Profiles page will open displaying a list of enabled User

Profiles.
£DQ Administration EDQ Administration ..e.x erlon
User Profiles s P :
| Address Verification
*| Email Verification
B Phone Verification User Profiles Configure AlBCDEIF G HIJKILMNOP QRS TUWVWXY Z other AN

Phone Settings (Enabled)

Action Profile
User Profile Settings.

Edit | Delete Analytics Cloud Integration User
Dataset Seftings

Advanced Seftings Edit | Delete Analytics Cloud Security User

Edit | Delete Authenticated Website

My Account Edt |Delste  Authenticated Website
Edit | Delete Chatter External User
EDQ Batch Edit | Delete Chatter Free User
Administration Edit | Delete Chatter Moderator User
Manage Batch Jobs Edit | Delete Chatter Only User
Batch Job Resuits Edit | Delete Company Communities User

A 2 Edit Delete  Contract Manager

1-100743 v/ 4 dPrevious Nexth b Page| 1 |ofs
Logout
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2. Click on the Configure button and you will be led to the Configure User Profiles page.

3. From the list on the left select the user profiles you would like to enable Phone verification for (e.g. System
Administrator).

4. Click on the Add button to enable Phone verification for the selected User Profiles.

EDQ Administration EDQ Administration

.,
s .
User Profile Settings ._experlc:n.,

*| Address Verification
*| Email Verification
8 Phone Verification

Save | | Cancel
Phone Settings (Enabled)

‘Confit u: Profile:
User Profile Settings onfigure liser Profiles

Dataset Settings Avialable User Profiles Enabled User Profiles
Advanced Settings Analytics Cloud Integration User Contract Manager ~
Analytics Cloud Security User Cross Org Data Proxy User
My Account Authenticated Website Custom: Marketing Profile
Authenticated Website Add Custom: Sales Profile
Chatter External User 4 Custom: Support Profile
EDQ Batch Chatter Free User q4 Customer Community Login User
o Chatter Moderator User Remove | Customer Community Plus Login User
Administration Chatter Only User Customer Community Plus User
Manage Batch Jobs Company Communities User Customer Community User
Batch Job Results Customer Portal Manager
Advanced Settings Customer Portal Manager Custom -
CLetamar Dartal W tandard
Logout
5. Click Save.

Configure Phone Verification Settings

To configure Phone Verification settings on a per User Profile basis follow the steps below:

1. Click on the User Profile Settings link. The User Profiles page will open displaying the enabled User
Profiles in a table.

2. Click on the Edit action link next to your User Profile from the table.

3. The Profile page will open. From that page, you can select specific settings on per User Profile basis for all
Objects for which phone verification Touchpoints have been created.

EDQ Administration Rddress Seftings

.,
s .
Customer Portal Manager Profile « EXperian.

*| Address Verification
*| Email Verification

B Phone Verification

Save Save &Close | | Cancel

Phone Settings (Enabled)

A it Settil
User Profile Settings ceoun —

Dataset Settings Validation Mode I Default [Interactive] w
Advanced Settings Auto Accept Default [Enabled]
My Account Default Country Code | Default [+44] v

Dataset Settings

The Dataset Settings additional option sets the returned phone number format based on the selected default
country in the “Enable Phone Verification for an Object” section.

For example, if your Default country is United Kingdom, the solution will pick up the aliases for United
Kingdom listed in the table below (see screenshot) and it will return verified phone numbers formatted
according to the specific phone format for UK.

Note: Configuring Dataset Settings for Phone Verification is only necessary if you have mapped the Phone
number field in the Output Mappings. If it is not mapped, EDQ phone verification service doesn‘t
standardize the entered phone number and leaves it as entered.
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.,
EDQ Administration EDQ Administration . )

Dataset Settings ..experlon.,
*| Address Verification

*| Email Verification

B Phone Verification Dataset Settings Hew Delete Selected | | Refresh DataSet Settings 01/2/3/4/5/6|7 8|9 Other All
Phone Settings (Enabled)
User Profile Settings [] Action Country Code Alias{es)
Dataset Setings [] Edt| Delete  +1 CAN, US, NORTH AMERICA, CAN, US, NORTH AMERICA, CAN, US, NORTH AMERICA
p— [] Edt| Delete  +1242 BS, BAHAMAS, BS, BAHAMAS, BS, BAHAMAS
[ Edt| Delete  +1246 BB, BARBADOS, BB, BARBADOS, BB, BARBADOS
MiyfAccomnt [ Edit | Delete +1268 AG, ANTIGUA AND BARBUDA, AG, ANTIGUA AND BARBUDA, AG, ANTIGUA AND BARBUDA
[ Edit| Delete  +1345 KY, CAYMAN ISLANDS, KY, CAYMAN ISLANDS, KY, CAYMAN ISLANDS
EDQ Batch [ Edt| Delete +1441 B, BERMUDA, BM, BERMUDA, BM, BERMUDA
Administration [] Edt| Delete  +1473 GD, GRENADA, GD, GRENADA, GD, GRENADA
Manage Batch Jobs [ Edt! Delete #1721 X, SINT MAARTEN, 5X, SINT MAARTEN, SX, SINT MAARTEN
Batch Job Results [ et Delte  +1767 DM, DOMINICA, DM, DOMINICA, DM, DOMINICA
A a2 O el Debte  +1734 WC, SAINT VINCENT AND THE GRENADINES, VC, SAINT VINCENT AND THE GRENADINES, VC, SAINT
WINCENT AND THE GRENADINES
e 1-100f195 [w] 0selected 4 APrevious Nexth p Page| 1 |of20

1. To edit the aliases for a specific phone country code, select the Edit action link or click on the New button
to create a new phone country code.

2. You will be taken to the Country Alias Settings page where you can see the following options:

Country code — add a new country code or edit an existing one from the dropdown.

Country aliases — add new or edit existing aliases in the Country aliases text box. To assign more than
one alias to a particular Country code enter the aliases separate by a comma.

.,
EDQ Administration Dataset Settings . ‘
5] Address Verificai Create New Dataset Settings ._experlon.,

*| Email Verification

& Phone Verification Dataset Settings Save | | Save &Close | | Cancel
Fhone Settings (Enabled) o -
User Profile Seftings Country Code I
Dataset Seftings Country Aliases l:l
Advanced Settings Allow Empty  []
Restore Defautts
My Account

Allow Empty — Checking this checkbox allows you to assign an empty value as an alias for the
selected Dataset.

Restore Default — clicking on this link allows you to reset the settings for this Country code.

Advanced Settings
The advanced settings give you full control over phone verification. We do not recommend changing these
settings without consulting with your EDQ representative.

1. Expand Phone Verification and click on the Advanced Settings link to be directed to the Advanced
Settings page. You will see the following fields:
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_ .
EDQ Administrati Phone Settings. le' pe '0
mimstraton Advanced Settings ‘s Xperian.

*| Address Verification

»| Email Verification

B Phone Verification Save | | Save & Close | | Cancel
Phone Settings (Enabled)
SR Ul Fa—
Dataset Seftings
Validation Message Timeout {sec) ||:|
Advanced Settings Cheose your Validation Status | Verified by Experian v
My Account Verified Certainties
Verified
Unverified
EDQ Batch d
Unknown
Administration Absent
Manage Batch Jobs Teleservice not provisioned

estore Defaults

£l

Batch Job Results
Advanced Settings

Logout

Timeout (sec) — The phone validation search timeout in seconds. The default setting is 8 seconds.

Validation Message Timeout (sec) — If the phone number entered by the user is invalid, a validation message
is displayed providing insight into the validation status, this setting determines how long the validation
message should remain visible on the page. The default setting is 6 seconds.

Choose Your Validation Status — This option provides you the ability to choose whether your verified status
to be “Verified by Experian” or “Verified by Experian QAS".

Verified Certainties — Certainty indicates the Phone status. This option allows you to set which certainties
should be considered verified and return a Phone Validation Status of “Verified by Experian”. Below are the

Certainty definitions.
Verified: Number format validated and number verified.
Unverified: Invalid number format supplied.
Unknown: Number has been blocked from lookups.

Absent: Number format validated and number verified via network lookup but not currently available

(i.e. phone off, out of range).
Teleservice not provisioned: Valid number but not active on network.
Restore Defaults - select this link if you wish to restore the default settings on the page.

2. Leave this page populated with Default and click Save & Close button.
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My Account

The My account section allows you to manage your application key, export and import settings and provides
support contact information.

EDQ Administration

| Address Verification

*| Email Verification
*| Phone Verification

My Account

EDQ Batch

Administration
Manage Batch Jobs
Batch Job Results
Advanced Settings

Logout

The Import and Export Setting options allow you to Export all of your configuration settings and Import into another Salesforce account.

.,
EDG Administration . 0
My Account ._expeI'ICIn
Application Key
Change Your Application Key Submit
Package Version 554
Import and Export Settings Import Settings | | Export Settings

Support Contact Information

Location Phone Email

Australia, Mew Zealand  Melbourne: +61 3 8622 1655
gassupport@au.experian.com

and Singapore Sydney. +61 2 8907 7272

EMEA +33(0)170394343 ems.support@experian.com
United Kingdom +44 (0) 207 498 7788 uk.support@gas.com

USA and Canada +1(888) 7123332 us.support@gas.com

All Others Provided by appropriate Support Location specified at point of sale

Hours

08:30- 18:00 AEST / Monday -
Friday

09:00 — 17:00/ Monday - Friday

08:30-18:00 GMT / Monday -
Friday

08:00-20:00 ET/ Monday - Friday

Application Key - You can register another Global Data Quality for Salesforce Application Key from this

section by adding the key in the field next to Change Your Application Key and clicking the Submit button.

Additionally, the version of the EDQ package will be displayed here.

Import and Export Settings — The import and export settings buttons allow users to export all configuration

settings to a csv file and import settings when required. This is particularly useful when backing up

configuration settings and when preparing for sandbox refresh activities. All address, email and phone

configuration settings will be including in the respective export and import functions, batch mode specific

settings will not be included.

Congratulations! Global Data Quality for Salesforce is now set up and ready to use. For instructions on how

to use the application please refer to the user manual.
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TROUBLESHOOTING

The topics in this section aim to resolve issues identified in live integrations since the release of Experian Data

Quality for Salesforce version 5.0.

Issue Details
Address / Email / Phone verification does not trigger using the new and edit Page 67
button overrides

You have checked that the solution is properly configured and overridden your

object’s Edit and New buttons, however when creating a new record or editing an

existing record address / email / phone verification does not trigger.

Address / Email / Phone verification does not trigger Page 68
When you try to validate an address / email / phone within your object using either

Interactive or Rapid Search or the Inline workflows, validation does not trigger.

Interactive Address / Email / Phone verification does not trigger Page 71
Interactive address / email / phone verification does not trigger on Save and the

Experian Data Quality page doesn't open.

Rapid Search Address verification or Inline Email / Phone does not work Page 74
When you click on the “Validate” button the validation process fails to start.

Validation Status and Validation Timestamp Fields do not populate correctly Page 76
After validating an address using either the Interactive or Rapid Search workflows

the Validation Status field value ends with an “!" (exclamation mark) and the

Validation Timestamp field is not populated.

Incorrect Address validation results in Rapid Search Page 77
When verifying an address using the Rapid Search workflow the validation pastes

back incorrect address data.

Unable to grant permissions to Experian Data Quality Page 78
The user receives an error "There was an error updating your configuration" after

clicking on the "Allow" button on the grant permissions screen.

Inline editing is disabled in the Detail page when overriding the “New"” and Page 79
“Edit” buttons

Inline Editing is not available on the Detail page when using the page override

implementation method.

Rapid Search (non-page override) does not paste back values to the Detail Page 82
page when using Enforced Usage

Rapid Search does not paste back values to the Detail page and does not close in

Internet Explorer when using Enforced Usage (Rapid Search non-page override

implementation method).

EDQ for Salesforce cannot prepopulate lookup fields Page 83
EDQ for Salesforce cannot prepopulate lookup fields by passing value to the URL

of the query string

The "Change Record Type" dialog does not pass the selected record type to Page 84

visualforce page overrides in Salesforce Lightning
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The EDQ Tab Does Not Appear in the Navigation Bar When the Package is Page 87
Installed

‘'URL No Longer Exists' Error Message is Returned on the Page Layout When Page 88
Using Dynamic Page Override Implementation Method

An error message ‘URL No Longer Exists’ is displayed on the page layout, when

Dynamic Page Override implementation method is utilized for Edit/New actions on

a record.

Unable to access EDQ admin panel on Safari browser for iOS (version 13 or Page 91

above) or MacOS (version 12 or above)
EDQ for Salesforce’s admin panel within the Salesforce org cannot be accessed
(returning “Authorization failed” error or web page loading indefinitely).
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Address / Email / Phone Verification Does Not
Trigger Using the “New” and “Edit” Button
Overrides

Symptoms

You have checked that the solution is properly configured and overridden your object’s Edit and New
buttons, however when creating a new record or editing an existing record address / email / phone
verification does not trigger.

Once you have clicked the New or Edit buttons, you will notice that the browsers URL contains a
nooveride URL query string parameter, this is an indication that the page override has not triggered as
expected.

& https://eu5.salesforce.com/00Q240000021Aer/e: 1&retURL=%2F00Q

Error Messages

None.

Issue

Your Salesforce instance URL is not listed as a Salesforce Remote Site and Experian Data Quality is unable to

retrieve your Object layout.

Solution

You must add your Salesforce instance URL to the Salesforce Remote Sites list.

New Remote Site

Action Remote Site Name + MNamespace Prefix Remote Site URL Active
Edit| Del  ApexDevMet _ hitp:fwwew.apexdevnet.com
Edit| Del QASLive _ hitps:/sfvs online. gas.com v
Edit| Del Salesforce _ hitps:'eub salesforce.com v
Edit| Del  Staaing _ https:/fstg.online.gas.com v

Follow the steps from “Add your Salesforce Instance URL to Remote Site Settings” section (page 20). If you use
a custom salesforce.com domain please refer to the Note in the same section.
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Address / Email / Phone Verification Does Not

Trigger

Symptoms

When you try to validate an address / email / phone using either Interactive, Rapid Search or Inline

verification workflows validation does not trigger.

Error Messages

None.

Issue

There are a few reasons why address / email / phone verification may not trigger.

Scenario 1: Your address’ or phone’s country cannot be mapped
to a valid dataset.

If you are trying to trigger Address or Phone Validation for a country which you are not licensed for, the

Validation process will not trigger.

Solution 1

Check Dataset Settings in the relevant administration section. Make sure that an entry or an alias in the

Dataset settings table exists with the exact value for dataset, your address country or phone country code.

Dataset Settings

Action

Edit| Delete
Edit| Delete
Edit| Delete
Edit| Delete
Edit| Delete

1-50f223 v

Scenario 2: Wrong Input Mappings.

Dataset Name
Afghanistan (AFG)
Albania (ALB)
Andorra (AND)
Angola (AGO)
Aruba (ABW)

AB|C|D(E|F|G|H|I|.

Inital Engine Flatten Picklists Alias{es)

Default
Default
Default
Default
Default

Enabled
Enabled
Enabled
Enabled
Enabled

AF
AL
AD
AD
AW
Nexth M

There is a chance you mapped the input address fields to the wrong Object fields (e.g. mapping Shipping

Street to the Country address field for the Billing address touchpoint).

68



Solution 2

Navigate to the “Touchpoint Creation” section (page 42) and check if the Input mapping for your Object is

correct.)

Input Mapping

Address Field  Object Field
| Street v | |Billing Country Q@
| City v | |Billing City -
| State v | |Billing State/Province 9
| Postcode | | Billing Zip/Postal Code Q@
| Country v | | Shipping Street -

Add Another Mapping

Scenario 3: Missing output mappings for your dataset.

If you are verifying addresses for more than one dataset / country you may not have created an Output

Mapping for some of your datasets. If there is no specific output mapping for each of your datasets you must

have a Default output mapping.

Error Message

Integration information: search result was “Failed”. Dataset settings for: {country name} cannot be found!

Please create an Output Mapping for Dataset: {country name} in the Administration area.

Solution 3

Create an Output mapping for the specific dataset for your touchpoint in the EDQ Administration area. For
more information on output mappings go to the “Touchpoint Creation” section (page 42).

Address capturs 1s not avaidable — please enter the address below!

Integrator information: search result was Failed
Dataset settings for: USA cannot be found! Please create an Output Mapping for Dataset: USA in the

Administration area.

Per Dataset Output Mapping

| Save | |Save& Clqsel |Canoe\| |De|e‘le|

Dataset | United States (USA) v
Layout | SalesforceTypedown v ‘
Object Field Address Field
| Billing Streat v| |8 Street (Name) | @ | 1. Three character IS0 country code =
| Billing Street v | |9 Street (Descriptor) v (| 2 Urbanization
3
| Billing City v | [13. City name 1@,
| Billing State/Province v [14 State code @ s
| Billing Zip/Pastal Cade v| [16 7IP Code v | @ | 6 Primary number
— 7. Street (Pre-directional)

| Billing Country v | [19. Country -2 Street (Name)

Add Another Mapping

9. Street (Descriptor)
10. Street (Post-directional}
11. Secondary number (Type)
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Scenario 4: Address / Email / Phone on the global level, object
level or touchpoint level is disabled.

EDQ Administration Address Settings
B Address Verification

Address Seflings (Enabled) Enable Address Verification Save

User Profile Settings

Dataset Settings
g | Enable Address Verification (¢

Advanced Settinas

Solution 4

Go to EDQ Administration and click on Address / Email / Phone Settings. Make sure that the "Enable Address /
Email / Phone Verification” checkbox is checked. Click on Edit next to your Object and check if the “Validate
on Entry” option is set to Enabled. Then click on Edit next to each Touchpoint and make sure if the "Validate
on Entry” option is set to Enabled as well.
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Interactive Address / Email / Phone Verification
Does Not Trigger

Note: The issues listed below are specific for the Interactive workflow. However please make sure you check
the issues listed in Address / Email / Phone verification does not trigger section above before
proceeding.

Symptoms
Interactive address / email / phone verification does not trigger on Save and the Experian Data Quality page
doesn't open.

Issue

There are a few possible reasons why Interactive address / email / phone verification may fail to invoke:

Scenario 1: You may have selected the wrong Validation Mode.

Solution 1

Select "Interactive” for Validation mode in the Object Settings section for your Object in the EDQ
Administration area. If you are utilizing the Interactive workflow make sure to select the Interactive validation
mode. In addition, go to Profile Settings in the EDQ Administration area and make sure that you have selected
“Interactive” or "Default” for your Object’s “Validation Mode".

validation Mode || Interactive v

Owverride Address on Last Screen Disabled ¥

Interactive Auto Accept Enabled *

Scenario 2: You haven’t created the Object’'s Data Quality Page
and the Redirect to Data Quality Page.

This is only necessary when you use the "Non-page override implementation method” for custom objects.
EDQ provides you with default implementations of these pages for the Account, Lead Contact and Contract
standard objects.

Solution 2

To create the two Visualforce pages please follow the steps outlined in the “Non-page override
implementation method” section (page 21).

71



Scenario 3: You haven’t added the Redirect to Data Quality Page
to your Object layout.

< | QaverrnaPagerane

Actions +[ Section
Expanded Lookups H +E]Blank Space

Custom Links

Related Lists AccountDynamicPage

Report Charts
Visualforce Pages
Canvas Apps -

AccountRedirectTo...

Account Detail Standand Bl v s
| Edit| | Delete | | Sharing | | Include Offlin

# Account Information (Header visi n edit only)

vF AccountRedirectToDataCualityPage

Account Owner  Samnle Llser

Solution 3

To add the Redirect to Data Quality Page to your Object layout please follow the steps outlined in the “Add
the "EDQRedirectToDataQualityPage” Visualforce page to your Object layout” section (page 24).

Scenario 4: You haven’t named properly your Data Quality Page.

If you are integrating with a custom object you might have misspelled the Object’s name or used the Object
Name instead of the Object APl Name in the Visualforce page name.

Solution 4

Check if you are using the correct object name when creating VF pages. See page 21 for “Non-page override
implementation method".
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file:///E:/QAS/CASalesForce/branches/SalesForceV5/development/Documentation/Installation%20and%20Configuration%20Guide/EDQRedirectToDataQualityPa_1%23_Add_the_

Scenario 5: You have not allowed redirects in your internet
browser, when using Non-page override.

Solution 5

Allow redirects so that the ExperianDataQuality page can be reached. Example screenshot from Chrome

HEE w
x

Pop-ups blocked:

browser.

ways allow pop-ups and redirects from https://

O Continue blocking

Scenario 6: Record page loads perceivably slower, preventing
the DataQualilyPage from invoking using Non-page override.

When using Non-page override, the service checks for amended pages in the last 5 seconds (default setting).
If the record loads slowly, this could prevent the verification service from invoking.

Solution 6

1. Go to Setup > Static Resources -> click on the name of EDQGlobalSettings

2. Click View file.

3. Download the ‘js’ file.

4. In atext editor amend the "InvokelnteractivelntervalFromLastUpdatelnSeconds" :"5" to a value higher
than 5 (10 for example).

5. Save the file.

6. Edit the EDQGlobalSettings static resource and upload the file you just edited.

NB! Please note that any amends made to the EDQ Admin panel will revert this change to the default '5".
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Rapid Search Address Verification or Inline Email /
Phone Does Not Work

Note: The issues listed below are specific for the Rapid Search workflow. However please make sure you
check the issues listed in Address / Email / Phone verification does not work section above before
proceeding.

Symptoms
When you click on the "Validate” button the Rapid Search validation process fails to start.

Issue

There are a few reasons why Rapid Search address verification may fail to invoke:

Scenario 1: You may have selected the wrong Validation mode.

Solution 1

Select “Rapid Search” for Validation mode in the Object Settings section for your Object in the EDQ
Administration area. If you are utilizing the Rapid Search workflow make sure to select the Rapid Search
validation mode. In addition, go to Profile Settings in the EDQ Administration area and make sure that you
have selected “Rapid Search” or “Default” for your Object’s “Validation Mode".

validation Mode || Rapid Search v
Default Dataset | United States (USA) v

Default Search Engine | Typedown ¥

Override Address on Last Screen Disabled ¥

Scenario 2: The “Invoke Search Engine With a Button” option is
not enabled.

Solution 2

You need to navigate to the EDQ Administration, select Edit next to your Object and choose Enable from the

dropdown next to the “Invoke Search Engine With a Button” option. This way the Rapid Search pop-up will be

invoked by clicking on the “Validate” button.

74



Validation Mode

Default Dataset

Default Search Engine

Override Address on Last Screen

Rapid Search Auto Accept

| Rapid Search

| United States (USA)

Typedown ¥
Disabled ¥
Disabled *

I Invoke Search Engine With a Button

Enabled =

Number of Rapid Search Invokes

B
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Validation Status and Validation Timestamp Fields
Do Not Populate Correctly

Symptoms

After validating an address using either Interactive or Rapid Search mode (Inline for email and phone) and
clicking Save, the Validation Status field value ends with an “!" (exclamation mark) and the Validation
Timestamp field is not populated.

Addresz 1 River Rd
Schenectady, NY 12345-6000
LUMITED STATES OF AMERICA

Validate

Address Validation Status  Verified by Experian QAS!

Address Validation
Timestamp

Product Interest

Error Messages

None.

Issue

This problem can occur when you haven't created the before update and before insert custom trigger for your

Object.

Solution

Follow the “Add a custom trigger to maintain Validation Status and Validation Timestamp” section (page 33)
to create the triggers for your object.
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Incorrect Address Validation Results in Rapid
Search

Symptoms
When verifying an address using Rapid Search mode, address elements paste back incorrectly.

Issue

EDQ will return verified addresses in the order that you mapped in the Output mapping. If parts of the address
are returned into the wrong Salesforce fields there is a possibility the output fields are mapped incorrectly.

Object Field Address Field

| Billing Street v| |2 Street 1 v
| Billing Street v 3. Street 2 v
| Billing City v 7. State/Province v
I Billing State/Province v 5. City M
| Billing Zip/Postal Code v 8. ZIP/Postal Code M
| Billing Country v 9. Country/Region v

Add Another Mapping

Solution

Make sure that the output mappings are correct. For more information see section Touchpoint Creation
(page 42).
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Unable to Grant Permissions to Experian Data
Quality

Symptoms
The user receives an error "There was an error updating your configuration" after clicking on the "Allow"
button on the grant permissions screen.

Issue

The user has enforced IP restrictions and the EDQ server's IP is not whitelisted.

Solution

There are two solutions to this issue:

1. Go to Administration Setup > Manage Apps > Connected Apps and click Edit next to Experian Data
Quality and set the IP Relaxation setting to "Relax IP Restrictions".

2. Go to Setup > Administration Setup > Security Controls > Network Access and add the IP of the EDQ

server.
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Inline Editing is Disabled in the Detail Page When

Overriding the “New"” and “Edit” Buttons

Symptoms
Inline Editing is not available on the Detail page when using the page override implementation

method. When users double click the field to edit a record inline edit functionality is not available and

when hovering over a supported field the pencil icon does not appear.

Issue

This is a limitation of Salesforce’s Inline Editor and is expected behavior when the Edit button has been

overridden. If inline edit functionality is required within the Detail page follow the steps below.

Solution / Workaround

Note: Follow the described steps if you would like to edit record details.

1. Go to Setup = Custom Code - Visualforce Pages.

2. Click the New button at the top of the Visualforce page to create a new Visualforce page.
3. Enter the following values:

Label: {Object Name} Detail Page

Name: {Object Name} DetailPage

4. In the Visualforce Markup tab enter the following code:

<apex:page StandardController="{Object API Name}" tabStyle="{Object API Name}"
sidebar="true" extensions="EDQ.DataQualityEnforcedUsageController"
action="{!Execute}">
<body>
<div class="loadingWrapperDivCustom"></div>
<div id="detailsBody" style="display:none">
<apex:stylesheet value="{!URLFOR($Resource.EDQ__DynamicPageCss)}"/>
<apex:stylesheet value="{!URLFOR($Resource.EDQ__EDQAssets,
‘styles/LightningCss.css')}" />
<EDQ:DataQualityDetailPageScripts
EnforcedUsageRefreshTouchpointsAction="{!Execute}"
Urls="{!Urls}"
DetailPageUrl="{!DetailPageUrl}"
DataQualityEnforcedUsageData="{!EnforcedUsageData}"
EnableEnforcedUsage="false"
IsDetailPagelLightningCompatability="true" />
<apex:detail inlineEdit="true" relatedList="true"
oncomplete="1loading(); execute();"/>
</div>
</body>
</apex:page>

5. Replace {Object APl Name} with the APl name of your object (e.g Account). If your Object comes from a

managed package make sure that you replace {Object APl Name} with the full Object APl name including

the object’s prefix and suffix.
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6. Click the Save button;

7. Navigate to the object for which you would like to utilize the detail page inline editing;
8. Open one of the existing records.
9. Navigate to Settings and click on Edit Page.
» o
EEE Sales Home Lleads s~  Accounts  Contacts ~ EDQ By
ACCOUNT Developer Console
Kristina Peycheva + Fallow Check Integratlon Status Change Recorc oval
Edlt Page
Type Phone Webslte Account Owner Industry Bllling Address
0 Kristina Peycheva £ Edit Object
DETAILS RELATED EDIT ACCOUNT DETAILS ACTIVITY CHATTER

10. Select the Tabs section within the page editor.

im Lghtning App Bullder - Account Record Page

¢ Back 7 Help

3 Desktop Shrink To View A4 ¢ Refresh

Lightning Components @

B Krisine Peycheva

w Standard (19)

[E] activties
Chatter

u Chatter Feed
Chatter Publisher
[E) Fter st

11. Click on the Details tab and remove its content.
12. Click the Add Component(s) here link.

13. Select Visualforce from the left-hand pane.

Page > Tabs

Default Tab

Detalls

Tabs
Detalls
Related

EdIt Account Detalls

Add Tab
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14. Using the Visalforce Page Name dropdown on the right-hand pane, select the page you've created in
step 2 and increase its height.

Page > Visualforce

Label

*Visualforce Page Name

Account Details Page
RELATED DETAILS

Height (in pixels)

| Account Details Page

680
) Email
| Accountname.

w Set Component Visibility

+ Add filter
Activity Timeline Y ¢ Expand All
Next Steps

No next steps. To get things moving, add a task or set up a meeting.
Past Activity

No past activity. Past meetings and tasks marked as done show up.
here.

v

| Bing acaress

15. Click the Save button.
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Rapid Search (Non-page Override) Does Not Paste
Back Values to the Detail Page When Using
Enforced Usage

Symptoms
Rapid Search does not paste back values to the Detail page and does not close in Internet Explorer
when using Enforced Usage (Rapid Search non-page override implementation method).

You have enabled Rapid Search Enforced Usage (non-page override) but the information does not
paste back and the Rapid Search popup doesn’t close in Internet Explorer.

Issue

There are two scenarios in which Enforced Usage (Rapid Search non-page override) will not paste back values
to the page. Listed below are steps you can follow to confirm if a scenario is prevalent.

Go to Internet Options, Security tab in your Internet Explorer browser:

1. Enable Protected Mode is unchecked.

The Salesforce domain for your account is added to Trusted Sites (e.g. https://eu3.salesforce.com).

The EDQ domain is NOT added to Trusted Sites (e.g. https://sfv5.online.qas.com).

2. Enable Protected Mode is unchecked.

The Salesforce domain is NOT added to Trusted Sites (e.g. https://eu3.salesforce.com).

The EDQ domain is added to the Trusted Sites (e.g. https://sfv5.online.qas.com).

Solution

Add both the Salesforce and the EDQ domains to Trusted Sites

1. Click the Internet Explorer Settings icon and click the Internet Options
2. Select the Security tab
3. Click on the Trusted Sites icon
4. Click the Sites button
5. Add the following URLs:
e your Saleforce domain e.g. https://eu3.salesforce.com
e https://sfv5.online.qgas.com
6. Click the Close button;

7. Click the OK button;
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EDQ for Salesforce Cannot Prepopulate Lookup
Fields

Symptoms
EDQ for Salesforce cannot prepopulate lookup fields by passing value to the URL of the query string
Solution__c=TestSolution1&Solution__c_lkid=50124000000LTRm&Solution__c_lkold=TestSolution1

Issue

This problem can occur when you haven't passed the correct parameters in the URL.

Solution

1. To be able to set pre-populate a lookup field via passing parameters to the URL query string of the page
pass the below three parameters:

FIELD_HTML_ID=FIELD_VALUE&FIELD_HTML_ID_lkid=FIELD_ID&FIELD_HTML_ID_lkold=FIELD_VALUE

e Replace {FIELD HTML_ID} with the HTML element id of the lookup field on the page.

e Replace {FIELD_VALUE} with the value you would like to pre-populate the field with.

e Replace {RECORD_ID} with the record id of the related sObject which has a value of FIELD_VALUE.

For example, to set the value to "Burlington" of the account look up field in contacts please pass the below
parameters:

Accountld=Burlington&Accountld_lkid=XYZ&Accountld_lkold=Burlington
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The "Change Record Type" Dialog Does Not Pass
the Selected Record Type to Visualforce Page
Overrides in Salesforce Lightning

Issue

As of Spring '17 the "Change Record Type" dialog (invoked on the record detail view) does not pass the
selected record type to Visualforce page overrides. Moreover this dialog cannot be overridden by custom
code.

Solution

Solution 1: Use a custom global action instead of the standard “Change Record
Type” action

Create a new custom global action

1. Go to Setup - User Interface 2> Global Actions = Global Actions. Click the New Action button to
create a new action.

2. Enter the following Action Information:

Action Type: Lightning Component

Lightning Component: EDQ:recordTypeSelector
Height: 250px

Standard Label Type: --None—

Label: Change Record Type (EDQ)

Name: Change_Record_Type_EDQ

3. Click the Save button.

Add the action to the object layout
1. Go to Setup - Object and Fields > Object Manager > {Object Name} (e.g. Account).

2. Navigate to the Page Layout section. Click on the arrow next to the desired page layout which you would
like to edit and click the Edit link.

3. Navigate to Salesforce1 and Lightning Experience Actions and click the wrench icon on the right to
override the defaults.

Salesforce1 and Lightning Experience Actions

i

Actions in this section are predefined by Salesforce. You can override the predefined actions to set a8 customized list of actions on Salesforced and Lightning Experience pages that use this
layout. If you customize the actions in the Quidk Actions in the Salesforce Classic Publisher section, and have saved the layout, then this section inherits that set of actions by default when you

dlick to ovemide. l
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4. From the selector at the top of the page select the Salesforce1 & Lightning Actions category and then
drag the Change Record Type (EDQ) action on the page layout somewhere before the standard Change
Record Type action.

5. Click the Save button.

6. Make sure to use the Change Record Type (EDQ) action instead of the standard one.

Solution 2: Use a Visualforce page instead of the standard “Record Type” field
in the layout

Follow the steps below if a record type field is used in a layout:

Standard Objects

7. Go to Setup - Object and Fields > Object Manager - {Object Name} (e.g. Account).
8. Navigate to the Page Layouts section and select a layout.

9. Remove the standard Salesforce record type field.

10. From the selector at the top of the page select the Visualforce Pages section, choose the page with the
same name (e.g. Account Record Type) and drag it to the page layout.

11. Once it is placed, hover over it and click on the Properties icon which looks like a wrench (™ ) positioned
in the upper right corner of the component.

12. A pop up with the Visualforce Page Properties will appear. Enter:

Width (in pixels or %): 100%
Height (in pixels): 40px
Show scrollbars and Show label should be left unchecked.

13. Click OK and then click Save.

Custom Objects

1. Go to Setup > Custom Code -> Visualforce Pages. Click the New button
2. Enter the following values:

Label: {Custom Object Name} Record Type

Name: {Custom_Object_ Name}RecordType

3. In the Visualforce Markup tab enter the following code:

<apex:page standardcontroller="{Custom Object Name}_ c"
extensions="EDQ.RecordTypeExt" applybodytag="false">
<body id="lightningStyle">
<apex:stylesheet value="{!URLFOR($Resource.DynamicPageCss)}" />
<apex:stylesheet value="{!IF(IsSalesforcel == true,
urlfor($Resource.EDQAssets, 'styles/LightningCss.css') , "' )}" />
<apex:form styleClass="customRecordType">
<span class="label">Record Type</span>
<span class="value">{!RecordTypeName}</span>
<apex:commandButton value="[Change]" oncomplete="change()"
styleClass="btn" rendered="{!hasRecordTypes}" />
</apex:form>
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</body>
<script>{!3S}</script>
</apex:page>

Replace {Custom Object Name} with the name of your object.

You may find the exact {Object Name} and {Object APl Name} by going to Setup - Object Manager. Select

your object to navigate to the Details section.
4. After you created your Visualforce page click Save.

5. Follow the steps 1-7 as per the standard object.
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The EDQ Tab Does Not Appear in the Navigation
Bar When the Package is Installed

Symptoms
The EDQ Administration tab is missing in the Salesforce Lightning navigation bar.

Issue

The EDQ Address, Email and Phone Validation Package has been installed, but the EDQ Administration tab
doesn't appear in the Salesforce Lightning navigation bar.

Solution

Please follow the steps below to add the EDQ Administration tab to the Salesforce Lightning navigation bar:

1. Go to Setup > Apps > App manager.

2. Navigate to the Sales for Lightning app in the Lightning Experience App Manager. Click on the arrow to
edit the app.

3. Navigate to the Select Items link on the top.
4. Select the EDQ tab and then using the arrow add it to the Selected Items list.

5. Click the Done button.
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‘URL No Longer Exists' Error Message is Returned
on the Page Layout When Using Dynamic Page
Override Implementation Method

Symptoms
An error message 'URL No Longer Exists’ is displayed on the page layout, when Dynamic Page Override
implementation method is utilized for Edit/New actions on a record.

Issue

Using Dynamic Page Override Implementation methods on Edit/New actions could return an error ‘URL No
Longer Exists’, when the user tries to access the page. (Please refer to the screenshot below)

earch Search ’; Switch to Lightning Experience Test Test v Setup Help

Leads Accounts Contacts Opportunities Forecasts Contracts Orders Cases Solutions Products Reports Dashboards EDQ

URL No Longer Exists

You have attempted to reach a URL that no longer exists on salesforce.com

You may have reached this page after clicking on a direct link into the application. This direct link mignt be-

+ A bookmark to a particular page, Such &5 a report or view

+ Alink to a particular page in tne Custom Links section of your Home Tab, or a Custom Link

+ Alink to a particular page in your email templates

If you reached this page through a bookmark, you are probably trying to access something that has moved. Please update your bookmark:
If you reached this page through any of the other direct inks listed above, please notify your administrator to update the link

Thank you again for your patience and assistance. And thanks for using salesforce.com!

Click Nere to return to the previous page.

Copyright ® 2000-2019 salesforce.com, inc. All rights reserved. | Privacy,_Statement | Securily Statement | Terms of Use | 508 Compliance | Go to Salesforce mobile app

This error outlines that the remote site setting for the current domain endpoint could be missing in the
environment.

Solution

To resolve the issue, the Salesforce domain of the organization should be added as Remote Site Setting. In
case the error persists please follow the steps below to review the exact endpoint, which should be added as
Remote Site Setting:

1. In Lightning Experience go to the Object tab, for which Dynamic Page Override implementation method is

utilized. (e.g. Accounts)

e Al v Search Accounts and more. *[~ ? x4

B Service Home Cratir Acouns v  Contacts v Cases v fepors v Dasnboards v

Accaunts
E Recently Viewed v # New | I
2 items - Updatad a few seconds ago Search this st B | Ee C F
ACCOUNT NAME ~ ACCOUNT SITE v PHONE ~  ACCOUNT OWNER ALIAS -
| IR ! (783) 2616201 Trest
2 Jr (820) 773-9051 TTest
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2. Open the browser console and go to the Network tab (Note: For different browsers the Network tab may
differ. In this example, Chrome is used.)

P DevTools - na53.lightning.force.com/lightning/ofAccount/list?filterName=Recent80.source=alohaHeader

[w ﬂ Elements Console Sources F’c—r—'crmance Memaory Application Security Audits JavaScript P

® O B Y Q  View I T Group by frame Preserve log ¥ Disable cache Offline  Online A
| Filter | #| Hide data URLs tlll XHR !5 CS5 Img Media Font Doc W3S Manifest Other
Bz 10 mz 15 ms 20 m 25 mz 30 mis 35 ms A0 me 45

3. Without closing the browser console, return to the Salesforce window. Click the New button or edit a
record.

» *[~ KR CW W,

i3 Service  Home Chatter Acounts v Contacts v Casss v Reports v Dashboards °

Accounts
D Geconty viewea v +

2 items - Updatad & mi Searcn tnis list @- E-

2 0g0
ACCOUNT NAME ~  ACCOUNT SITE v PHONE “ ACCOUNT OWNER ALIAS v
1 Dickensan plc (785) 241-6201 Trest -

ty of Arizor (820)

9051 TTest -

4. Return to the Network tab in the browser console. You should see a list of all resources executed by
triggering the New button. Find the {Object}DynamicPage URL reference in the list, where {Object} is the
object for which the Dynamic Page Override implementation method is utilized. For this example, Account
object is used. (Please refer to below attached screenshot):
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5. Hover over the dynamic page reference. Right click and select Copy Link Address

Mame Status Type

aura?r=26&aura.NavEventhManager.getClassicNonSetupPageReferenceMappings=1 200 .

oK
efent=Account&_CONFIRMATIONTOKEN =VmpFPSxNakF4TTMwd...cBf35f789c8T6&1tn_app_id=06mf20000018dFGAAY &icle=0 302

001 Moved Temporarily
ePent=Account8_CONFIRMATIONTOKEN =VmpFPSxNakF4T1Mwd...cBf95f789cB76&tn_app_id=06mf20000016dFGAAY 8iclc=0 302 T
«t/h

nas3.salesforce.com/001 Found nm
AccountDynamicPage?ent=Account8_COMNFIRMATIONTOKEM =...53.Jightning.force.com&save_new=18isfdc.override=1 200 d 0
edq.naS3.visual force.com/apex ok ocumen

QOpen in Sources panel
SfdcCore.js 200 .

o w tab seript
edqunaS3.visualforce.com/jslibrary/15504 T ok crip
AuraAlohaFrameNavigator.js Clear browser cache 200 ot
= I . g o scrip
edq.naS3visual force comfjslibrany/ 15475 L ok
aura?r=278=ura NavEventianager.getCl ¥ 200 hr

Copy 4 Copy link address oK
aura?r=288wi-force-components-contre C thaa 200 .

Block request URL oK xar

~ Copy response headers
symbols.svglcache=9.24.0 Block request domain 200
; . . Copy response o swg+xml
7 Sutility-spr ] oK

Save all as HAR with content .
aura?r=29&ui-instrumentaticn-compone Copy as PowerShell 200 .

Save as.. oK e

Copy as fetch
Copy as cURL (emd)
10 requests | 233 KB transferred | 1.8 MB resources
Copy as cURL {bash)
:  Console What's New Search Copy all as PowerShell
¥ | © | Filter Copy all as fetch Default levels ¥
Copy all as cURL (emd) Log XMLHttpRequests
Copy all as cURL (bash) ¥ Eager evaluation
Copy all as HAR | Autocomplete from history

¥ Group similar

6. Return to the Salesforce window and paste the copied URL. Add parameter &edqShowError=true at the
end of the URL. Press Enter. The cause of the error should appear:

edq.na33.visual.for

&« c 8 https//edq.na53

[3 RedmineTextFormat... An Introduction to... how can You can as... Execution Governor... [ ] PDF Converter - Cs Component Library = egit- gitstashand.. [ git-flow cheatsheet [ IntelllIDY

Unauthorized endpoint, please check Setup->Security->Remote site settings. endpoint = https://na53.salesforce.com/services/Soap/u/35.0

An unexpected error has occurred. Your solution provider has been notified. (EDQ)

7. Copy the provided endpoint from the message on the page layout and add it as Remote Site Setting.
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Unable to access EDQ admin panel on Safari
browser for iOS (version 13 or above) or MacOS
(version 12 or above)

Symptoms
EDQ for Salesforce’s admin panel within the Salesforce org cannot be accessed (returning
“Authorization failed” error or web page loading indefinitely).

Issue

This problem can occur when Safari is set to prevent cross-site tracking which in the case of EDQ disallows the
browser from sending cookies containing important session and setting data to the EDQ backend servers.

Solution

1. For Safari on MacOS: Click on Safari menu (top left of screen), click on Preferences, click on Privacy,
and uncheck "Prevent Cross-Site tracking". After that click on Manage Website Data and click on
“Remove All".

Privacy

¢t Qal0e B o

Passwords Search Security Privacy. Websites Extensions Advanced

I Website tracking: | | Prevent cross-site tracking |
Ask websites not to track me

Cookies and website data: | | Block all cookies

Manage Website Data...

Apple Pay: Allow websites to check if Apple Pay is set up

Safari allows you to make purchases on the web using
Apple Pay from your Apple Watch or iPhone.

2. For Safari on iOS: Go to the iDevice's Settings (cog wheel app), tap on Safari, uncheck "Prevent
Cross-Site tracking"; make sure that Block All Cookies is unchecked; then tap on “Clear History and
Website Data”.
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3.

{ Settings Safari
Content Blockers Z

PRIVACY & SECURITY

Prevent Cross-Site Tracking *

Block All Cookies
Ask Websites Not To Track Me
Fraudulent Website Warning

Camera & Microphone Access

ololele

Check for Apple Pay

Allow websites to check if Apple Pay is set up.
About Safari & Privacy...

Clear History and Website Data

Cleaning website data will log you out of your org and you will need to enter your credentials again.
After this you should be able to access the EDQ admin panel without issue.
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